
































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































Appendix A: 
Reserved Words 

I Pascal, like any programming language, has a set of words that are reserved for 
particular purposes. This appendix summarizes these words by category. In all 
categories, case is irrelevant; upper- and lower-case characters in the word produce 
the same result (e.g., integer is equivalent to INTEGER and Integer). 

Word Symbols 

The words in the following list appear in boldface when formatted by pretty 
printing. Under no circumstances can these words be used as your variable, constant, 
procedure, or function identifiers. 

(Note: the word symbols otherwise, string, and uses are specific to 
MacPascal; the remaining symbols are part of the "ANSI Standard" Pascal.) 

and array begin case con st div 
do downto else end flle for 
function goto if in label mod 
riil not of or otherwise packed 
procedure program record repeat set string 
then to type until uses var 
while with 

Lightspeed Pascal includes all of the above, plus the following symbols: 

lnllne interface Implementation unit 

Predefined Type Identifiers 

I The following words are predefined atomic data types. (MacPascal considers string 
to be a special case, so it is listed as a word symbol.) These words can be used on the 
right side of colons in variable or parameter declarations. 
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boolean 
double 
longint 

char 
extended 
real 

Appendix A: Reserved Words 

computational 
integer 
text 

Standard Procedure and Function Identifiers 
The following words are names of predefined procedures and functions in MacPascal 
and QuickDraw. These words can be used as identifiers, although you should avoid 
doing so whenever possible. If you redefine a standard procedure or function name, 
the MacPascal interpreter or Lightspeed compiler will use your definition rather than 
the predefined definition. Thus, if you create a procedure called Writeln, any call in 
your program to Writeln will call your procedure rather than the predefined 
procedure. 

The Standard Pascal procedures and functions are defined in the ANSI standard 
and thus are available in all versions of Pascal. The MacPascal procedures and 
functions are specific to THINK Technologies' Macintosh Pascal and Lightspeed 
Pascal software, but functions similar to these are available in many versions of 
Pascal. The MacPascal list also includes extensions to the operating system software. 
The QuickDraw procedures and functions are found in Macintosh's read-only 
memory; thus, similar procedures and functions should exist in all languages 
available on the Macintosh. In MacPascal (not Lightspeed), the QuickDraw2 
procedures and functions are available only when the statement uses QuickDraw2; 
follows the program declaration. 

By convention, each word in a procedure or function name is capitalized. 

Standard Pascal Procedures and Functions 
Abs Arctan Chr Close Cos 
Dispose Eoln Eof Exp FilePos 
Get Ln New Odd Ord 
Ord4 Open Pack Page Pointer 
Pred Put Read Readln Reset 
Rewrite Round Seek Sin Sqr 
Sqrt Su cc Trunc Unpack Write 
Writeln 

MacPascal Procedures and Functions 
Button BlockMove Con cat Copy 
Delete DisposeHandle Drawline EventAvail 
GetDrawingRect GetTextRect GetHandleSize GetMouse 
GetNextEvent GetSoundVol HideAll Include 
Insert lnvertCircle Length NewFileName 
NewHandle Note OldFileName Omit 
PaintCircle Pos ReadString Save Drawing 
SetDrawingRect SetSoundVol SetTextRect ShowDrawing 
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ShowText SizeOf Sound Done StartSound 
Still Down StopSound StringOf Synch 
Sys Beep Tick Count WaitMouseUp Write Draw 

QuickDraw Procedures and Functions 
Add Pt CharWidth DrawChar Drawstring 
DrawText EmptyRect Equal Pt EqualRect 
EraseArc EraseOval EraseRect EraseRoundRect 
FillArc FillOval FillRect FillRoundRect 
FrameArc FrameOval FrameRect FrameRoundRect 
GetFontlnfo GetPen GetPenState GetPixel 
GlobalTolocal HideCursor Hide Pen lnitCursor 
lnsetRect lnvertArc lnvertOval lnvertRect 
lnvertRoundRect Line Line To LocalToGlobal 
Map Pt MapRect Move Move To 
ObscureCursor OffsetRect PaintArc PaintOval 
PaintRect PaintRoundRect Pen Mode Pen Normal 
Pen Pat PenSize Pt2Rect PtlnRect 
PtToAngle Random Scale Pt SectRect 
SetCursor SetOrigin SetPenState Set Pt 
SetRect ShowCursor Show Pen Space Extra 
String Width Stuff Hex SubPt TextFace 
TextFont TextMode TextSize TextWidth 
UnionRect 

QuickDraw2 Procedures and Functions 
BackColor ClosePicture ClosePoly Close Port 
CloseRgn ColorBit Copy Bits CopyRgn 
DiffRgn DisposeRgn DrawPicture EmptyRgn 
EqualRgn Erase Poly EraseRgn Fill Poly 
FillRgn ForeColor Frame Poly FrameRgn 
GetClip GetPort GrafDevice lnitGraf 
lnitPort lnsetRgn lnvertPoly lnvertRgn 
Kill Picture Kill Poly Map Poly MapRgn 
MovePortTo NewRgn OffsetPoly OffsetRgn 
Open Picture Open Poly Open Port OpenRgn 
PaintPoly PaintRgn PicComment PortSize 
PtlnRgn RectlnRgn RectRgn ScrollRect 
SectRgn SetClip SetEmptyRgn Set Port 
SetPortBits SetRectRgn SetStdProcs Std Arc 
Std Bits StdComment Std Get Pie Std line 
Std Oval Std Poly StdPutPic StdRect 
StdRgn StdRRect StdText StdTxMeas 
UnionRgn XorRgn 
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Appendix B: 
Standard Functions 

This appendix lists the predefined functions and their purposes. For each function, the 
following notation is used: 

< result type> := <function name >{< parameter list-type>); 

This does not imply that functions must be used in assignment statements; functions 
can be nested inside expressiOns or passed as parameters. 

The < result type > and parameter types use the following codes: 

integer 
real 

n numeric (integer or real) 
s string 
c character 
b boolean 
o ordinal type (integer, character, boolean, or enumerated type) 
p pointer variable 

Thus, the first notation below means that the function Abs takes a parameter 
of type integer and returns a value of type integer. 

Arithmetic Functions 
i :: Abs{i); 
r == Abs{r); 

b == Odd{i); 

i == Sqr{i); 
r := Sqr{r); 

r := Sqrt(n); 

r := Sin{ < radians - n > ); 

r := Cos{< radians- n >); 

{ absolute value } 

{ returns TRUE if i is odd} 

{ square of a number} 

{ square root of a number } 

{ returns sine of angle n } 

{ returns cosine of angle n } 
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r := Arctan( < radians-n > ); {returns arctangent of angle n} 

r := Exp(n); {returns e to the nth power} 

r == Ln(n); {returns natural log of n} 

i := Random; {returns random integer between -32767 and 32768} 

Ordinal Functions 

i := Ord(o); 

c :: Chr(i); 

o := Succ(o); 

o := Pred(o); 

String Functions 

i := Length(s); 

{ returns ordinality of o } 
{ if o is a character, Ord returns ASCII value} 

{ returns character with ASCII value of i } 
{ i should be between o and 255} 

{ returns successor of value} 
{ result is same type as parameter } 

{ returns predecessor of value} 
{ result is same type as parameter} 

{ returns length of string } 

i := Pos(< pattern - s >, < source - s >); 
{returns position of< pattern> in< source>} 

s := Concat(< str1 - s >, < str2-s >, ... , < str n- s >); 
{ concatenates strings } 

s == Copy(< source - s >, < start- i >, < numChars - i >); 
{returns substring starting at< start>} 

s := Omit(< source - s >, <start - i >, < numChars - i >); 
{ returns everything except specified substring } 

s := Include(< source - s >, < includeStr - s >, < pos - i >); 
{ inserts < includeStr > in < source > at < pos > } 

Memory Manipulation 
{ Ok, ok, so they aren't functions, but they had to go somewhere ... } 

New(< pointer variable >); { allocates memory for pointer 

Dispose(< pointer variable>); {frees memory from pointer 
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Appendix C: 
Input/Output Procedures 
and Functions 

Textual Input 
Read(< var1 >, < var2 >, ... <var n >); 

{ reads input from keyboard 

Readln(< var1 >, < var2 >, ... <var n >); 
{ reads input from keyboard 

Read(< text var>, < var1 >, < var2 >, ... < var n >); 
{ reads input from file 

Readln(< text var>, < var1 >, < var2 >, ... <var n >); 
{ reads input from file; moves file pos to next line 

Textual Output 

{ In the following statements, < exp >denotes an expression -
{i.e., a constant, variable, function, or combination thereof. 
{ Each expression can be followed by formatting as follows: 
{ < exp > : < field width > 
{ Real expressions can be formatted as follows: 
{ < exp > : < field width > : < precision > 

Write(< exp 1 >,<exp 2 >, ... ,<exp n >); {writes output to Text window 
Writeln(< exp 1 >,<exp 2 >, ... ,<exp n >); 

{ writes output to Text window and skips to next line 

Write(< text var>,< exp 1 >, <exp 2 >, ... ,<exp n >); {writes output to file 
Writeln(< text var>,< exp 1 >,<exp 2 >, ... ,<exp n >); 

{ writes output to file and skips to next line 



Graphic Output 

Graphic Input 
b := Button; {returns TRUE when button has been pressed 
GetMouse(< horiz >, < vert >); { gets position over which mouse is placed } 

Graphic Variables Manipulation 
{ set rectangle and point variables } 
SetRect(< rect var>, < left>, <top>, < right>, < bottom >); 
SetPt(< point var>, < horiz >, < vert >); 

b := PtlnRect(< point Var>, < rect Var>); 
{ returns TRUE if< point Var> is in < rect Var>} 

{ work with regions } 
< rgnHandle variable > := NewRgn; 
OpenRgn; 
CloseRgn(< rgnHandle >); 
DisposeRgn(< rgnHandle >); 

{ moving and resizing objects } 

{ allocate memory for region } 
{ begin defining region } 
{ end of definition } 
{ free memory from region } 

OffsetRect( < rect var>, < diffHoriz >, < diffVert > ); 
OffsetRgn( < rgnHandle >, < diffHoriz >, < diffVert > ); 
lnsetRect( < rect var>, < diffHoriz >, < diffVert > ); 
lnsetRgn( < rgnHandle >, < diffHoriz >, < diffVert > ); 

Graphic Output 
HldePen; {takes ink out of pen} 
ShowPen; {places ink in pen} 
PenPat(< black, white, dkGray, gray, ltGray >); 

MoveTo(< horiz >, < vert >); 
Move(< horizDiff >, < vertDiff >); 
Line To(< horiz >, < vert >); 

{ changes color of pen 

{ moves CP to designated position 
{ moves CP using relative coords 

{ draws line to designated pos; moves CP 
Line(< horizDiff >, < vertDiff >); 

{draws line using relative coords; moves CP 
Drawllne(< horiz1 >, < vert1 >, < horiz2 >, < vert2 >); 

{draws line from (< horiz1 >,< vert1 >)to(< horiz2 >, < vert2 >) 

WriteDraw(< exp 1 >, <exp 2 >, ... < exp n >); 
{ writes output to Drawing window at current position 
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{ A reference to < rect > in the following procedure calls 
{ can be replaced by< top>, <left>,< bottom >,<right> 

{ draw outline of shapes} 
FrameRect(< rect >); 
FrameOval(< rect >); 
FrameArc(< rect >, < startAngle >, < numDegrees >); 
FrameRoundRect(< rect >, < ovalWidth >, < ovalHeight >); 

{ < ovalWidth >and< oval Height> determine roundness of corners} 
FrameRgn(< rgnHandle >); 

{ draw shapes filled in current pen pattern } 
PaintRect(< rect >); 
PaintOval(< rect >); 
PaintArc(< rect >, < startAngle >, < numDegrees >); 
PaintRoundRect(< rect >, < ovalWidth >, < ovalHeight >); 
PaintRgn(< rgnHandle >); 
PaintCircle(< centerHoriz >, < centerVert >, < radius>); 

{draw shapes in background color} 
EraseRect(< rect >); 
EraseOval(< rect >); 
EraseArc(< rect >, < startAngle >, < numDegrees >); 
EraseRoundRect(< rect >, < ovalWidth >, < ovalHeight >); 
EraseRgn(< rgnHandle >); 

{ change pixels in shape from black to white or vice versa} 
lnvertRect(< rect >); 
lnvertOval(< rect >); 
lnvertArc(< rect >, < startAngle >, < numDegrees >); 
lnvertRoundRect(< rect >, < ovalWidth >, < ovalHeight >); 
lnvertRgn(< rgnHandle >); 
lnvertCircle(< centerHoriz >, < centerVert >,<radius>); 



Appendix D: 
Menu Summary 

XN 
Open... KO 
Close 
Saue 
Saue Rs .•• 
Reuert 
Page Setup ••. 
Print ••• 
Quit KQ 

Cut il8H 
Copy il8C 
Paste Kil 
Clear 
Select All KR 

Macintosh Pascal Menus 

File 
New: Creates a new program window. 
Open ••• : Brings up a dialog box from which you can choose a file to work with. 
Close: Closes the current window but does not leave MacPascal. Asks if you want 

to save changes since the last Save. 
Save: Saves the current version of the file. If the file has not been titled, Save has 

the same effect as Save As .••. 
Save As ••• : Saves the current version of the program and asks you to name the 

program. A dialog box asks you to give the program a title, indicate which disk 
should contain the file, and whether you want to save the program as text, as an 
application, or as an object. (Typically, you want to save the program as text.) 

Revert: Restores the file to its state at the last Save. 
Page Setup: Allows you to make any changes necessary for printing. 
Print ••• : Prints the contents of the program window on whatever printer is 

connected to the Mac. 
Quit: Performs the same function as Close and then returns control of the screen to 

the Finder. 

Edit 
Cut: Removes the selected text from the program window and places it in the 

clipboard. 
Copy: Copies the selected text from the program window to the clipboard. 
Paste: Inserts the contents of the clipboard at the insertion point. 
Clear: Removes the selected text from the program window. 
Select All: Selects the entire contents of the program window. 
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Find 88F 
Replace KR 
E11erywhere KE 
What to find... KW 

Check XK 
Reset 

Go XG 
Go-Go 
Step XS 
Step-Step 

Stops In 

Untitled 
Instant 
Obserue 

Tefft 
Drawing 

Clipboard 

Font control ... 
Preferences ••• 

Appendix D: Menu Summary 

Search 

Find: Finds the next occurrence of the text in the Search for box (from What to 
find) within the program window. 

Replace: Replaces the selected text with the contents of the Replace with (from 
What to find) box. 

Everywhere: Repeats the Find-Replace sequence continually until the end of the 
program is reached. 

What to find: Allows you to designate the text to Search for, the text to 
Replace with, whether you want to find all occurrences or only whole-word 
occurrences of the Search for text, and whether case matters. 

Run 

Check: Checks your program for syntax errors. This will not catch all errors, 
particularly those that involve communication between two statements, but it will 
indicate many. 

Reset: Resets all windows to their state before the program is executed. 
Go: Runs your program until execution reaches the mainline's end ot until a stop 

sign is found. 
Go-Go: Runs your program from start to finish, pausing at each stop sign just long 

enough to update the Observe window. 
Step: Executes the next statement in the program. 
Step-Step: Executes one statement at a time, stopping when a stop sign is reached. 
Stops In: Inserts a gutter for stop signs. If the gutter is already there, the option is 

Stops Out. 

Windows 

Program, Instant, Observe, Text, Drawing, Clipboard: Makes the 
designated window current. If the window is not currently visible, choosing its 
naine in the Windows menu makes it appear on the screen. 

Font Control ••• : Brings up a dialog box that lets you change the fonts in the 
Program windows (the Program, Observe, and Instant windows) or the Text 
window. 

Preferences ... : Allows you to change the size of the indentation, tab stops, and 
the number of characters saved in the Text window. Also allows you to echo-print 
the contents of the Text window to a printer or file. 



Lightspeed Pascal Menus 

New KN 
Open... KO 
Close 

Saue 
Saue Rs ... 
Saue a Copy Rs ... 
Reuert 

Page Setup ••• 
Print ••• 

Delete ••• 

Transfer ... 
Quit KQ 

Cut KH 
Copy KC 
Paste KU 
Clear 
Select RH 

Show Selection 
Stum1 l:rrnr 

Find KF 
Replace KR 
Euerywhere KE 
Find What ••• KW 

Lightspeed Pascal Menus 

Many of the menu options in Lightspeed Pascal perform the same function as an 
option in Macintosh Pascal. When appropriate, we point you to the equivalent 
function in the lists. 

File 
New, Open ... , Close, Save, Save As ••• : See the same commands in 

Macintash Pascal's File menu. 
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Save As. .. : Saves the current version of the file being edited and asks you to name 
(or rename) the file. A dialog box asks you to give the file a title, indicate which 
disk should contain the file, and whether you want to save the text only or the 
entire document (which includes stop signs). 

Save a Copy As ••• : Make a backup copy of the file being edited. A dialog box 
asks you to name the backup file. When the copy has been created and saved, you 
will still be editing the original file. 

Revert, Page Setup ... , Print ••• : See the same commands in Macintosh 
Pascal's Fiie menu. 

Delete ... : Deletes a file from the file system. A dialog box appears asking you to 
choose the file to delete. After you choose the file, you will be asked to confirm 
the deletion. 

Transfer ••• : Quits Lightspeed Pascal and then sends you to another available 
application (such as a word processor or spreadsheet program). 

Quit: Performs the same function as Close on all open files and then returns 
control of the screen to the Finder. 

Edit 
Undo: Allows you to reverse the effect of the last editing action. You can only undo 

the previous action; that is, you cannot undo all the way back to the beginning. 
Cut, Copy, Paste, Clear, Select All: See the same commands in Macintosh 

Pascal's Edit menu. · 
Show Selection: If you have selected text that is no longer visible in the active 

window, this option scrolls to a place in the window where it becomes visible. 
Show Error: If your program's execution or compilation halts because of an error, 

and the thumbs down icon is no longer visible, this option scrolls to a place in 
the appropriate program window where the thumb icon is visible. 
Find, Replace, Everywhere, Find What ... : See the same commands in 

Macintosh Pascal's Search menu. Note that the Find What. •• option in 
Lightspeed and the What to Find... option in Macintosh Pascal are identical. 
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N(H!• Pro j(H t,,, 

01>1rn PrnJ•~i:1 ... 
Close Project 

Add Window 
Add File ••• 
Re moue 

Build & S11ue Rs ••• 

Uiew Options ••• 
Run Options ••• 
Source Options ••• 

Check 3CK 
Build 3€8 
Check Link 
Reset 

Go 3CG 
Go-Go 
Step 3CS 
Trace 3CT 

Huto-Saue 
• Confirm Saues 

Don't Saue 

Appendix D: Menu Summary 

Project 
Note: Projects in Lightspeed can contain multiple program files. Only one project 
can be open at a time. 
New Project. •• : Creates a new project. 
Open Project ••• : opens an existing project. 
Close Project: Closes the. current project. 
Add Window: Adds the file· ~urrently being edited to the project. If the file being 

edited is untitled, you will be asked to save the file first. 
Add File ... : Performs the same function as Add Window but allows you to choose 

files other than those that are currently open. You will see the same dialog box 
from the Open ••• or Open Project ••• option. This dialog box reappears after 
each addition until you choose the Cancel button. 

Remove: Before choosing this option, you should double-click on a file listed in 
the project window. When you choose this option, the highlighted file will be 
removed from the project. 

Build & Save As ••• : Compiles the project and saves the compiled code as an 
application, library, or compressed project. 

View Options ••• : Brings up a dialog box which lets you alter the format of the 
project window. 

Run Options ••• : Allows you to change the number of characters saved in the Text 
window and to echo the Text window output to the printer or to a file. Also 
allows you to work with resource files and application stack and zone sizes, but 
you won't need to do that here. 

Source Options ... : Allows you to specify the font, length of indentation, and 
width of tab stops in the editing windows. 

Run 
Check: See Check in Macintosh Pascal's Run menu. 
Build: Compiles the project code. 
Check Link: If you are writing a program using multiple files, this option allows 

you to see if the links between the compiled files are ok. 
Reset, Go, Go-Go, Step, Trace: See the same commands in Macintosh Pascal's 

Run menu. Note that the Trace option in Lightspeed and the step-step 
option in Macintosh Pascal are identical. 

Auto-Save, Confirm Saves, Don't Save: Only one of these three options is 
active at any given time. Auto-Save automatically does a Save on all changed 
files before the program is run. Confirm Saves asks if you want to save 
changes made to your files before the program is run. Don't Save means you 
don't want to save changes before the program is run. 
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Show Finger 
Pull Stops 

.,1Ruto-Show Finger 

....Stops In 

....Step Into Calls 

Break at A-Traps 
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Debug 
Show Finger: No, this option does not perform an obscene gesture. Rather, it 

makes visible the finger-pointing icon indicating the next line to be executed. If 
the file containing the program is not open, the finger points to the file name in 
the project window . 

Pull Stops: All stop signs are removed from the active file window. The stop sign 
gutter remains. 

_M_<_•<_sb_,_, ___ :•_:M... Note: When any of the next three options are enabled, a check mark appears next to 

Generic Proj... 88P 
1---------------

LlghtsBug 8U 
lnst11nt 
Obserue 

Te Ht 
Or11wing 

!------·-------
Clipbo11rd 

. Progr11m 1 881 
AUBllBble >l!<2 

the option in the menu. Choosing an enabled option will disable it. 
Auto-Show Finger: (See also: Obscene gestures made while driving.) Useful for 

programs with code in multiple files. When the program is run with Go-Go, 
Step, or Trace, the window containing the line of code being executed becomes 
the current window so that the finger-pointing icon is always visible. 

Stops In: Inserts the stop sign gutter. 
Step Into Calls: When you run a program with Go-Go, Step, or Trace while 

this option is enabled, the finger-pointing icon will step through each procedure 
and function call. When disabled, the finger-pointing icon will only step through 
the mainline. 

Break at A-Traps, Macsbug: Low-level debugging tools. 

Windows 
Project, LightsBug, Instant, Observe, Text, Drawing, Clipboard, 
Program: Choosing any option on this menu makes that window active. A 

diamond to the left of a program window name indicates that changes have been 
made xsince the last Save. (LightsBug is another low-level debugging tool.) 
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Appendix E: 
Editing Time-Savers 

Macintosh Pascal and Lightspeed Pascal contain many features that help you enter, 
edit, and execute programs. All you must have to use MacPascal and Lightspeed is 
explained in section 1.3, but a number of other features can make your online time 
more efficient. Two features that are particularly useful for debugging - the Observe 
and the Instant windows - are explained in Chapters 2 and 7, respectively. Some 
other features are discussed here. You should read the Primer and Chapter 1 before 
using this appendix. 

This hands-on section discusses a program that prints two addresses. Suppose 
you want to use your Macintosh to create mailing labels. At the moment, you have 
only two addresses to print: 

Al Gorithm 
Box 1248 
Finite State Univ. 
College Town, MA 02912 
555-5555 

Dee Morgan 
Box 101 
Finite State Univ. 
College Town, MA 02912 
555-0011 

The first obvious breakdown of the problem is: print one address, followed by 
the other: 

Print Al's address 
Print Dee's address 

You notice that the two addresses contain two identical lines. You decide to 
make these lines into a separate procedure. The pseudocode can be refined as follows: 

{ Print Al's address } 
Print Al's name and box number 
Call procedure to print college, state, zip 
Print phone number 
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CodeE.1 
program Malling 

{ Print Dee's address } 
Print Dee's name and box number 
Call procedure to print college, state, zip 
Print phone number 

If you make each address a separate procedure, you can translate the pseudocode 
into the following Pascal program. (Do not type this program in yet; you will be 
given instructions on what to do later.) 
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CodeE.1 
(continued) 

Editing Tricks 

If you are using Macintosh Pascal, 

• Open MacPascal. 

If you are using Lightspeed, 

• Duplicate Generic Project. 
• Rename the copy as Mailing. 
• Open Mailing. 

For both MacPascal and Lightspeed, 

Appendix E: Editing Time-Savers 

• Enter the program header and procedures CollegeState and Al. 

You may notice that the procedures Al and Dee are similar. (If you cannot see 
the entire lines, you may want to resize the Untitled window.) At this point, you 
realize that it would be easier to edit a second copy of Al to create Dee instead of 
retyping all of the similar statements. To avoid this repetition, you can use a 
technique called copying and pasting. 

• Select the Al procedure, including the header comment. 

The selected text, as usual, will be highlighted; your program window should look 
like Figure E. l. 

• Choose the Copy option from the Edit menu. 

This option makes a copy of the selected text and puts it on the Macintosh 
Clipboard. If you choose Clipboard from the Windows menu at this point, you 
will see another copy of the procedure Al. (Again, you may have to resize the 
window to view the entire contents.) 

Now, you need to insert this copy into the program. 

• Move the insertion point to the place where the procedure Dee should go. 
• Choose Paste from the Edit menu. 



Editing Tricks 

Figure E.1 
Highlighted text 

Figure E.2 
Result of Paste 

Untitled 

begin 
Write 1 n( 'Fi nite State Univ'); 
Writeln('Co11ege Town, MA 02912') 

end; { Coll egeSt~t~ } 

You now have two copies of the procedure Al, as shown in Figure E.2. 
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• Modify the second copy of the procedure Al to create the procedure Dee. 

Suppose you decide to switch the order of the procedures Al and Dee. As long 
as these procedures are between the procedure CollegeState and the mainline, it 
doesn't matter if Al comes before Dee, or vice versa. 

Writeln('Al Gorithm'); 
Writ el n('Box 1248'); 
CollegeState; 
Wri tel n('555-5555') 

end; { Al } 

Untitled 

{ This procedure prints A l's address. 
{Called by: Mainline Calls: none 

procedure Al; 

begin 
Writeln('Al Gorithm'); 
Writel n('Box 1248'); 
Co 11 egeState; 
Writ el n('555-5555') 

end; {Al ~ 
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• Select the text to move (procedure Dee). 
• Choose Cut from the Edit menu. 

As before, the selected text appears in the clipboard, but unlike Copy, the cut 
text disappears from the program window. 

• Choose the place where the cut text should be pasted by moving the insertion 
point. 

• Select Paste. 

The text from the clipboard is added at the insertion point. 
The cutting/copying and pasting techniques can be summarized as follows: 

1. Select the text to move. 
2. Choose Cut or Copy from the Edit menu. (The text will disappear from 

the program but will be visible if you look at the Clipboard.) 
3. Move the insertion point to the place where the text should go. 
4. Choose Paste. (The text will now appear at that point.) 

The other options on the Edit menu are not used as often as cutting, copying, 
and pasting. The Clear option, like Cut, removes any selected text from the 
program. Unlike Cut, though, the selected text does not appear in the Clipboard and 
thus cannot be pasted. The Select All menu simply allows you to select 
everything in the current window. 

• Complete the rest of the program by entering the mainline. 

Finding and Replacing 
Suppose you decide to change the phone numbers printed on the labels by adding the 
area code (351 ). There are two ways to change the phone numbers using menu 
options. We'll look at each in turn. 

First, you can automatically tnove the insertion point to a desired section of 
text in the program. In this case, we want to find the phone numbers that begin with 
the sequence 555-. 

• Move the insertion point to the top of the program. 

- In Macintosh Pascal, choose the What to find option from the 
Search menu. 

- In Lightspeed Pascal, choose the Find What option from the Edit menu. 

When you choose this option, you will see the dialog box illustrated in 
Figure E.3. 

What you want to do is replace each occurrence of 555- with (351) 555-. This 
requires a few steps. 

• Enter the text 555- in the Search for box. 
• Enter the text (351) 555- in the Replace with box. 



Finding and Replacing 

FigureE.3 
What to find/ 

Find What dialog 
box 

Search for [ 
:::::=========================================~ 

Replace with [ 
~~~~~~~~~~~~~~~~~~~~~~ 

® Separate Words 

0 Hll Occurrences 

®Case Is lrreleuant 

O Cases Must Match 

OK 

Cancel 
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You now need to address the two options at the bottom of the box. On the left, 
you can choose to find Separate Words or All Occurrences. A "word" in this 
context is any set of characters surrounded by blanks. Since the 555- is not 
surrounded by blanks, you need to: 

• Choose the All Occurrences option. 

The other option asks if Case Is Irrelevant or if Cases Must Match. 
The Case is Irrelevant option means that the words First, first, FIRST, and 
flrSt are taken to match the text First. The Cases Must Match option will not 
match words if the case of the letters (upper or lower) is different. Since case doesn't 
matter here, 

• Choose the Case Is Irrelevant option. 

This option may already be filled. MacPascal typically assumes that you are looking 
for separate words and that case is irrelevant. 

Now that you have filled in all of the information, you can go on. 

•Choose the OK button. 

The dialog box goes away, but otherwise the screen does not change. The 
What to find/Find What option is useful only as a preparation for the Find, 
Replace, and Everywhere options. (These options are on the Search menu in 
MacPascal and on the Edit menu in Lightspeed.) You can now change the first 
phone number. 

• Move the insertion point to the top of the program. 
• Choose Find from the Search or Edit menu. 

The first occurrence of the text listed in the Search for box, in this case, the 
text 555-, is found. The search starts at the insertion point, which is why you moved 
the insertion point to the top of the program. The text sequence is highlighted, as 
shown in Figure E.4. 

Now you can replace the text. 

• Choose the Replace option from the Search or Edit menu. 

The text in the Replace with box of the What to find/Find What dialog 
box replaces the selected text, as shown in Figure E.5. 

• Change the other phone number by choosing Find and Replace. 
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-D Mailing 

{Celled by: Mainline Cells: none 

procedure Al ; 

begin 
Writeln('A l Gorithm'); 
Writel n('Box 1248'); 
Col legeStete; 
Wri tel n('B5555') 

end; {Al} 

{ This procedure prints A l's address. 
{Celled by: Mainline Cells : none 

procedure Dee; I 
Figure E.4 ~:Jibill]]egilillilfilnill]]ilmlfilill]]ilmlfilill]]ilmlfilill]]ilmlfilill]]ilmlfilill]]ilmlfililmlfillfilill]]ilmlfilI2J[Q~ 

Result of Find ~ 121 '2J 

Appendix E: Editing Time-Savers 

Using a Find and Replace is fine when you have to make only a few isolated 
changes. You may, however, have a change that occurs many times in a program. 
Then you can perform what is called a global replacement. This means that you can 
change every occurrence of the Search for text to the Replace with text with one 
action. 

-0 

Suppose you have the area code wrong - it is actually 357 instead of 351. 

• Choose the What to find or Find What option. 
•Indicate that you want to Search for 351 and Replace with 357. 

Mailing 

{Celled by: Mainline 

procedure Al ; 

begin 
Writeln('Al Gorithm'); 
Wri tel n('Box 1248'); 
CollegeStete; 

Cells : none 

Wri tel n('""W,,.,,..,UWl..,,,.,,.,,.5555') 
end; {Al} 

{ This procedure prints A l's address. 
{Celled by: Mainline Cells: none 

procedure Dee; 

Figure E.5 begin ~ 
Result of Replace ~2-~!I:Jillilmlfil~ill]]ilmill]]ilm~~lfilill]]lfilill]]lfilill]]ilmlfililmlfil~[filililll2~12J~ 



Making Windows Active and Readable 649 

Notice that selection works in the dialog boxes in the same way that it does in 
the program window. 

• Move the insertion point back to the top of the program. 
• Choose Everywhere from the Search or Edit menu. 

This option makes the global replacement. Because such changes can be far­
reaching, a dialog box asks if you really want to make this change. If you choose 
Yes, the global change is made, and the final replacement is highlighted. 

Making Windows Active and Readable 
Any MacPascal window can be made active by clicking in it. There is another way to 
make a window active. The Windows menu lists, among other things, the program 
file name, Text, Drawing, Instant, Observe, Clipboard, and (in Lightspeed 
only) the project name. Choosing any of these options makes that window the active 
window. 

The style in which characters appear on the screen is called the font. All of the 
windows, except the Text window, use the same font. You can change the font or the 
size of the characters using menu options. 

To change the font of the windows (except the Text window) in Macintosh 
Pascal: 

• Choose Font Control from the Windows menu. 
• Click on the button next to the words Program Windows. 
• Click on the Next and Prev buttons to view the different fonts. (A sample 

appears on the left side of the box.) 
•When you see the font you want, choose OK. 

To change the font of the windows (except the Text window) in Lightspeed: 

• Choose Source Options ... from the Project menu. 
• Click on the left and right arrow buttons to view the different fonts. (A 

sample appears in the box at the top.) 
•When you see the font you want, choose OK. 

To change the font of the Text window in Macintosh Pascal: 

• Follow the same procedure as above, EXCEPT that you should click on the 
button next to the words Text Window. 

To change the font of the Text window in Lightspeed Pascal: 

• Follow the same procedure as above, EXCEPT that you should choose the 
Run Options ... from the Project menu. (The sample will appear in the 
box to the right of the font name.) 

As we noted in Chapter 1, MacPascal automatically indents subordinate 
statements, such as those between a begin and end. The indent width is the length 
of the indentation, in pixels. (The entire Mac screen is 512 pixels wide.) You can 
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change the length of indentation simply by entering a different number in the 
corresponding box. 

The same dialog box that lets you change the length of indentation also allows 
you to change the number of pixels in each tab. The tab stops are just like the tabs 
on a typewriter and can be used to line up comments. 

To change the length of indentation or tab stops: 

• In Macintosh Pascal, choose the Preferences ••• option from the Windows 
menu. 

• In Lightspeed Pascal, choose Source Options ••• from the Project menu. 
• Click in the box that you want to change (Indent Width or Tab Stops 

every in MacPascal; Indent: or Tab Stops: in Lightspeed). 
• Enter the new number of pixels. 

Textual Output 
When you output characters to the Text window, they are printed from left to right, 
starting at the top of the window. If there is more text than fits in the window, you 
can scroll through the output with the scroll bars. However, MacPascal and 
Lightspeed both have an upper limit on how many characters they can hold in the 
Text window. The Preferences ..• dialog box in MacPascal and the Run 
Options... dialog box in Lightspeed ask you to set the upper limit for characters. 
Usually the default setting of 5000 is sufficient; however, you can set an upper limit 
as high as 32767 characters. 

To change the number of characters saved in the Text Window: 

• In MacPascal, choose the Preferences ••. option from the Windows 
menu. 

• In Lightspeed, choose Run Options ••. from the Project menu. 
• Then click in the box to the right of the words Text Window saves. 
• Enter the new number of characters (up to 32767). 

The Print ••• option on the Run menu prints only the code. Often, it is 
helpful to get a hard copy of your program's output as well. 

To send Text window output to the printer in Macintosh Pascal: 

• Choose the Preferences ••• option from the Windows menu. 
•Click on the box next to the line Output also to Printer. 
• Choose the OK button. 

To send Text window output to the printer in Lightspeed Pascal: 

• Choose the Run Options ••• option from the Project menu. 
• Click on the box next to the line Echo to the printer. 
• Choose the OK button. 
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If you run a program with an X next to the Output also to Printer or 
Echo to the printer option, everything that appears in the Text window is "echo­
printed" on the printer connected to your Macintosh. 

Finally, you can save the contents of the Text window in a file. 

To send Text window output to a file in Macintosh Pascal: 

• Choose the Preferences ••• option from the Windows menu. 
• Click on the box next to the line Output also to a File: 
• Another dialog box will appear. Enter the name of the file in this dialog box 

and choose Save. 
• When you return to the original dialog box, choose the OK button. 

To send Text window output to a file in Lightspeed Pascal: 

• Choose the Run Options ... option from the Project menu. 
• Click on the box next to the line Echo to the tile. 
• Another dialog box will appear. Enter the name of the file in this dialog box 

and choose Save. 
• When you return to the original dialog box, choose the OK button. 

Final Shortcuts 

Many of the frequently used menu options can be performed with key sequences. For 
example, the Go option on the Run menu can also be specified by simultaneously 
pressing the cloverleaf key and the G key. The equivalent key sequences are listed on 
the menus. 

Mouse actions can also be used for shortcuts. If you want to select a word, 
double-click on it. If you want to select an entire line, triple-click on it. 

Finally, there are four shortcuts that are useful in all Macintosh applications. 
Each of these require pressing the cloverleaf, shift, and a number key at the same 
time. 

Command 
Cloverleaf-Shift-I 
Cloverleaf-Shift-2 
Cloverleaf-Shift-3 

Cloverleaf-Shift-4 

Action 
Ejects the disk in the internal drive 
Ejects the disk in the external drive 
Saves the contents of the screen in a 
MacPaint file 
Prints the contents of the screen if the printer 
is on 
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Appendix F: 
The Macintosh Character Set 

0 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

0 16 32 48 64 80 96 112 128 144 160 176 192 208 224 240 
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The decimal representation of any character is found by adding the row and the 
column numbers (e.g., the representation of G is 64 + 7, or 71). 

NUL stands for the null character (represented by 0); SP stands for the space 
character (represented by 32). 

Characters 0 through 31 and the DEL character (represented by 127) are 
nonprinting "control codes," which are used by the computer and display to perform 
various functions, but which are of no concern for out string comparisons. 



Appendix G: 
Syntax Summary 

Punctuation 

Elements In Compound Data Structures 
< recorclName >.<field > 
< arrayVar >[<subscript>] 
< arrayVar >[< sub1 >, ... ,<sub n >] 
[< element1 >, ... , <element n >] 
< pointerToRecorcl >11.< field> 

Arithmetic Symbols 
+ { addition, union of sets } 

{subtraction, negation, difference of sets} 
* { multiplication, intersection of sets } 
I { division of real numbers} 

{equal to} 
< { less than } 
> { greater than } 
< = { less than or equal to, subset of } 
>= { greater than or equal to, superset of } 
< > { not equal to } 

Other Symbols 

{ } 
{ assignment } 
{comments} 
{subrange, as in an array} 

{ element in 1-dimensional array} 
{ element in n-dimensional array } 
{ set of elements } 

{separates variables and functions from types} 
{ separates items in a list } 

' " 
(* *) 
( .. ) 
$ 
In 

{ statenierit separator} 
{ delimits a character or string } 
{alternative comment symbols} 
{ alternative array subscript symbols } 
{ indicates a hexadecimal number} 
{ containment in a set } 

653 



654 

Program Order 

{ header comment} 
program <program name>; 

uses< library>; 
con st 

< name > =<value >; 

type 
< typeName > = < pre-defined type>; 

{ Mainline variables} 
var 

< varName > : <type>; 

{ block comment 
{ function that receives one value parameter 

Appendix G: Syntax Summary 

{glossary} 

{glossary} 

{glossary} 

function < FunctionName > (< parameter name >:< parameter type>) : {glossary} 
< returned value type>; 

{ local variables } 
var 

< varName > : <type >; 

begin 
<statement 1 >; 
<statement 2 >; 

< statement n >; 

{glossary} 

< FunctionName > := < returned value > { returning value to caller} 
end; { FunctionName} · 



Program Order 

{ block comment 
{ procedure that receives one value and one variable parameter 

procedure< ProcName >(<parameter name>:< parameter type>; 
var< parameter name>: < parameter type>); 

{ local variables } 
var 

< varName > : <type >; 
{glossary} 

begin 
<statement 1 >; 

<statement n > 
end; { ProcName} 
{ Mainline block comment} 
begin 

<statement 1 >; 

< ProcName >(< parameter 1 >, < parameter 2 > ); 
<variable>:=< FunctionName >(<parameter 1 >); 

<statement n > 
end. { Program } 

{ Call procedure 
{ Call function 
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{glossary} 
{glossary} 
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Control Structure 
case < selector > of 

< integer, char, or enumerated constant> : < statement>; 
<integer, char, or enumerated constant> : <statement>; 
otherwise 

< statement > 
end;{ case} 

Appendix G: Syntax Summary 

for< integer variable > := < bounds ><to, downto > < bounds >do 
< statement>; 

If< boolean expression >then 
< statement > 

else If< boolean expression >then 
< statement > 

else 
<statement>; 

while < boolean expression > do 
< statement >; 

repeat 
<statement>; 

until < boolean expression >; 

with < record1 >, ... < record n >do 
< statement>; 

NOTE: Any occurrence of < statement > can be replaced with multiple statements 
using the structure: 
begin 

<statement 1 >; 
< statement 2 >; 

< statement n > 
end; 

The begin/end brackets are necessary to separate multiple statements within each 
control construct except repeat-until. 



Declaring Compound Types 

Declaring Compound Types 

type 

grades = array[1 .. 1 OJ of class; 
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{some examples 

{ 1-d array of defined type 

colorCount = array[1 .. 10, 4 .. 25J of integer; { 2-d array 

class= record 
name :string[15J; 
grade : integer 

end; { class} 

wordPtr = Asentence; 
sentence = record 

currentWord: strlng[1 OJ; 
next: wordPtr 

end; {sentence} 

classes= (Frosh, Soph, Jr, Sr}; 

charSet = set of char; 

student = record 
idNum: integer; 
case year: classes of 

Frosh: ( 
}; 
Soph, Jr: ( 

}; 

major: string[1 OJ; 
onLeave: boolean 

Sr: ( 
futurePlans: strlng[SOJ 

} 

{ record with 2 fields 
{glossary 
{glossary 

{ pointer of node in linked list 
{ single node in linked list 
{ field of node 
{ -- > next word in sentence 

{ enumerated type } 

{ set; base type must have < 65536 values 

{ record with fixed and variant parts 
{fixed field 
{tag field 
{ variant fields 
{ no extra fields when year=Frosh 

{ variant when year=Soph or } 
{ when year=Jr 

{ variant when year=Sr 

end; { end for both case and record } 
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Answers to Exercises: 
Selected Concepts 

Chapter 1 
1. The input of the computer process is similar to getting materials for a laboratory 

experiment; the processing of data is similar to performing the experiment; the 
output of the computer process is similar to the results of the experiment. 

2. Items a, b, c, g, and i are hardware; the remaining are software. 

3. A high-level language is closer to English than a low-level language; high-level 
languages are thus easier for the user to understand. 

4. The text appears in outline form; a bug box appears on the screen. 

5. To divide and conquer a problem is to break it into smaller parts and then to solve 
(conquer) the smaller parts. 

6. Writeln outputs a carriage return; Write does not. 

7. a. comment brackets - to be ignored by translator; b. apostrophes - surround a 
literal string (in Writeln, indicates text to print); c. semicolon - separates 
statements; d. boldface - reserved word 

8. The end is not a statement in itself; with begin, it forms a set of brackets or 
parentheses. 

9. a and care legal; bis illegal (cannot begin an identifier with a number). 

10. Comments make the program easier for programmers to read while debugging and 
for other programmers who want to understand or modify the code later. 

12. Get eggs, milk, bread, orange juice from refrigerator; get frying pan, spatula, 
measuring cup, plate, glass from cabinet; get cooking oil; put bread in toaster; 
press button to start toaster; pour 1/4 cup milk in cup; crack eggs in cup; stir 
eggs and milk with fork; place frying pan on stove; pour a little oil into the pan; 
turn on stove to medium heat; wait about 60 seconds; pour eggs and milk into 
pan; wait about 60 seconds; with spatula, turn eggs in pan; wait another 60 
seconds; turn off stove; with spatula, place eggs on plate; when toast is done, 
place toast on plate; pour orange juice in glass. 



13. a. Third, First, Second, mainline 
b. output: 

Number 3 
Number 1 
Number 3 
Number 2 
Number 3 
Number 1 
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14. a. check for missing apostrophes (syntax is incorrect); b. check for semicolon on 
line next to thumb - if not there, check lines above thumb; c. make sure 
procedures are in correct order in file; look for ChangeCredit in file. 

Chapter 2 
1. a. 52; b. 2; c. 5; d. 13.5; e. 47.12385 (rounded) 

2. The algebraic expression makes no sense, since it says that i is equal to i + 1; the 
assignment statement makes sense, since it says to add 1 to the value of the 
variable i and to store the result back in i. 

3. If the left of an assignment statement is an integer variable, the right side can 
have real variables, as long as the final result is an integer (which can be done 
with the Trunc and Round functions); if the left is real, the right side can 
contain both integer and real variables. 

4. pi is a predefined constant; area must be a variable; radius may be either a 
variable or constant. 

5. The CP ends up at (100, 100). 

lU Drawing 

6. a. numPeople gets 5; b. totalBill gets 24.75; c. totalBill gets 25.99; 
d. onePersonPart gets 5.19. 



660 

7. band dare legitimate inputs. 

8. Writeln('$', (numChocs/Price):5:2); 

Chapter 3 

1. (50, 150) 

2. ~D Drawing 

3. PaintArc(50, 50, 150, 150, 270, 180); 

Answers 

4. Code produces the lower right quarter-circle (a 90° arc) of a circle centered at 0, 0. 
The user's point specifies how large the quarter-circle is. 

5. PaintRect(50, 50, 150, 150); or lnvertRect(50, 50, 150, 150); 

6. D Drawing 

~ 

121 
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7. The result is a circle; the example will draw the same circle as Frame0val(60, 
60, 70, 70); 

8. The area stays gray, although different individual pixels will be lit. 

9. Draws a line segment from (100, 100) to the user's point. 

Chapter 4 
1. multiples of 4 not divisible by 400 

2. balance = 20, output is "You have a surplus of cash"; balance = 0, output is 
"You have a surplus of cash"; balance= -15, output is three lines: "You owe 
money," "Balance has been reset to O.," "You have a surplus of cash." To 
change, eliminate the semicolon after the end, and replace if balance >= 0 
then to else. 

3. if (playerNum = 7) and (playerNum mod 7 = 0) then 
Writeln('fizz-fuzz') 

else if (playerNum = 7) or (playerNum mod 7 = 0) then 
Writeln('fizz') 

else 
Writeln(playerNum); 

4. case place of 
1: 

Writeln('1 st'); 
2: 

Writeln('2nd'); 
3: 

Writeln('3rd'); 
otherwise 

Writeln(place:1, 'th') 
end; {case} 



662 Answers 

5. A real expression cannot be used as the selector to a case statement. To fix, 
change the selector line to case Trunc(coin * 100) of and change the 
selector values to 100, 50, 25, 10, 5, and 1. 

6. var 
redPrice, bluePrice, 
redSize, blueSize: real; 

begin 

{ price of colas 
{ size of cola cointainers, in ounces 

Write('Enter the price and size of Red Cola'); 
Readln(redPrice, redSize); 
Write('Enter the price and size of Blue Cola'); 
Readln(bluePrice, blueSize); 
Writeln('Red Cola costs', redPrice/redSize:3:1, 'cents per ounce'); 
Writeln('Blue Cola costs', bluePrice/blueSize:3:1, 'cents per ounce'); 
If redPrice/redSize > bluePrice/blueSize then 

Writeln('Red Cola is the better buy.') 
else If redPrice/redSize < bluePrice/blueSize then 

Writeln('Blue Cola is the better buy.') 
else 

Writeln('Neither cola is a better buy.') 
end; {procedure} 

7. if distance >= 0 then 
Writeln(distance) 

else 
Writeln(distance * -1) 

8. begin and end brackets needed around two assignment statements following if. 

9. if geneLikes and rogerLikes then 
Writeln('Two thumbs up') 

else If geneLikes or rogerLikes then 
Writeln('Split decision') 

else 
Writeln('Two thumbs down'); 

10. Currently, any value of numToBuy over 10 will yield a 10% discount; to fix, 
change the conditions so numToBuy is compared to 30 first, followed by a 
comparison to 20, and finally a compairson to 10. 

Chapter 5 

1. 
* 
** 
*** 
**** 
***** 
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2. initialization: lower limit; method of changing: automatically adds 1 to counter; 
exit condition: comparison of counter to upper limit. 

Drawing 

4. a. lists the even numbers from 2 to 98; b. will print the value 2 infinitely 

5. Currently, the code is an infinite loop; begin and end brackets should surround 
the three lines after the while 

6. The for loop executes one too many times; to fix, change the lower limit from 1 
to 2 or change first assignment statement to result := 1. 

7. Exits when winnings is greater than 5000 or winnings < losses. 

8. The code establishes one point when the user clicks the mouse button; then, it 
interactively draws a line from that first point to the mouse's current position 
until the user clicks the button again. (This technique is known as 
"rubberbanding. ") 

9. The first repeat can be changed to while not Button do - the first until 
Button; can be eliminated - the second repeat can be changed to while not 
Button do and begin - the second until Button; can be changed to end;. 

10. It will be executed 1 + 2 + 3 + ... (numPlayers - 1) + numPlayers times. 

Chapter 6 

1. No, because they act the same way within the begin and end brackets. 

2. A value cannot be passed back to an expression. 

3. A constant or an expression can be sent only to a value parameter; a variable can 
be sent to either a value or variable parameter. 

4. A variable parameter is used when the value that you send might change and the 
sending procedure needs to know about that change. 
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5. A function is appropriate when you. want to return a single value. 

6. a. percent = 10.0 and price = 35.0; b. percent = 10.0 and price = 33.39; 
c. discount = 10.0 and price = 35.0; d. The output is the three lines "The sale 
price is $31.50," "The sale price is 10.00% off the normal price," and "With tax, 
the total price is 33.39." 

7. a. both are value; b. numl, num2 are variable, num3 is value; c. numl is 
variable, num2, num3 are value; d. numl is value, num2, num3 are 
variable; e. numl, num3, num4 are variable, num2, numS are value. 

8. formal: SalePrice(percent, price); 
actual: procedure SalePrice(percent: real; var price: real); 

9. { This function asks the user to choose a point with the mouse. When the user } 
{ chooses a point, PickPoint returns the coordinates of the point. } 

function PickPoint: point; 

var 
horiz, vert: integer; 
userPoint: point; 

10. formal: 

{ returns point chosen by user 

{ coordinates of user's point 
{ name of user's point 

procedure Init(var count, total: integer; var average: real); 
procedure Update(var count, total, integer; newValue: integer; 
curAverage: real); 
actual: 
Init(count, total, average); 
Update(count, total, number, average); 

Chapter 7 
11. Add declarations for local variables horizMUI and vertMUI; put parentheses 

around left + right in first statement and top + bottom in second 
statement. 

12. Change procedure body to: 

begin 
done :'"' FALSE; 
repeat 

Write('please enter a shoe size or', sentinel : 2, 'to exit:'); 
Readln(shoeSize); 
If (shoeSize <>sentinel) then 

Checklnventory(shoeSize, curStock); 

if curStock <'"' 0 then 
begin 

Writeln('no shoes left'); 



done:=TRUE 
end 

until done or (shoeSize =sentinel); 
end; { ProcessShoeOrders} 

13. Move an-ange := 1; between begin of while loop and for statement. 

Chapter 8 
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1. char is more appropriate when you need an ordinal type, such as the selector of a 
case statement. 

2. const 
pop=""; 

3. The first statement is legal if start is declared as a boolean; the second statement 
is legal if start is declared as a string. 

4. Length and Pos and lncl"ude return integers; Concat, Copy, Include and 
Omit return strings. 

5. All are false except b. 

6. a. 'A'; b. 'BCDEF'; c. run-time error caused 

7. a. 5; b. 3; c. 'pizzapizza'; d. 'zz'; e. 4;f 1; g. 3; h. 'za'; i. O;j. 'zzpped'; k. 'zapped' 

Chapter 9 
1. Open opens a read-write file; Reset opens a read-only file; Rewrite opens a 

write-only file. 

2. If treated as integers, there are 4 components; if treated as string[8], there are 2 
components. 

3. If read as integers, component 0 is 555; if read as string[S], component 0 is 
'5551212'. 

4. The code prompts for an excuse which it reads from the keyboard and then writes 
to the file Excuses. The prompting, reading, and writing continues until the 
user enters the sentinel string 'NO MORE'. 

5. The Writeln statement cannot write to a read-only file. 

6. The file contains the string The second line'. 

7. a. at the first< eoln >marker; b. at the< eof >marker; c. at the top 
(component 0) of the file Something. 



666 

8. { This program copies the contents of one file into another. 
{ One line at a time is read from the first file and written into 
{the other. This stops when the end of the first file is reached. 

program Exercise8; 

var 
inline: string(40]; 
file1, 
file2: text; 

Chapter 10 

{ line to copy 
{ original file 
{ file to become copy 

1. a. (Note that FrameArc does not affect a region definition) ; 

~O Drawing 

b. 

0 Drawing 

w 

'21 

Answers 
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c., d. (c and d produce the same output) 

D Drawing .... 

'2J 

4. Among other things, writing external documentation before writing code helps to 
catch conceptual errors because it forces you to think out data structure and 
algorithm issues early on. It is easier to make design changes before the code is 
written. 

5. Negative coordinates are possible in both coordinate systems. 

6. The point (-70, - 40) in the Drawing window is the same as (242, 90) in the 
screen coordinate system; Drawing's (-100, 60) is screen's (212, 190); 
Drawing 's (53, 82) is screen's (365, 212); Drawing's (15, - 45) is (327, 85). 

Chapter 11 

1. a, b, and c are legal since figure and number can both be used in place of 
integer in this code; d is illegal since digit is a char. 

2. a. illegal because elements must be increasing; b. legal; c. illegal because array 
declarations cannot be used in parameter lists (types must be used instead); d. 
legal; e. illegal - to have a 2-dimensional array, the ranges should be rewritten 
as [1..size, 1 .. size];f illegal for same reason as c; g. illegal for same 
reason as a ; h. legal 2-dimensional array type declaration 

3. If key is not in the array, the loop will execute until curElem receives the value 
maxFlights + 1. At that point, when the loop condition is checked, both sides 
of the and will be evaluated, and the condition (flightNums[curElem] = 
key) will cause an out-of-bounds error. 

4. When counter is 4, numbers contains (in order from 0 to 5) -1, 2, 16, 44, 9, 
37. When counter is 5, numbers contains -1 , 2, 9, 16, 44, 37. 
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5. {This procedure draws an object of up to 30 points. The 
{coordinates of the first point are chosen by the user. Then, 

6. 

{ the procedure draws the rest of the shape by using the 
{relative coordinates stored in the array. (This is similar to 
{the code used to draw a square at a given point in Chapter 2) 

a. Mozart b. 2 c. Bartlett 
Bach 3 Mozart 

Beatles 1 Beatles 

Bartlett 4 Bach 

7. {This program reads a series of integers from a data file. It 
{ picks out the highest number with each ones digit, that is, 
{the highest number that ends in 0, that ends in 1, and so on. 
{These highest numbers are then printed. 

program Concept?; 

var 
most: array[0 .. 9] of integer; 
key: integer; 
ctr: integer; 
dataFile: text; 

8. const 
male= 1; 
female =2; 
drama= 1; 
comedy=2; 
singing =3; 
dancing =4; 
ageless13 = 1; 
age13_17=2; 
age18_25 = 3; 
age26_35 = 4; 
age36_ 45 = 5; 
age46_60 = 6; 
age0ver60 = 7; 

type 

{ highest with each digit 
{ current item from file 
{ loop counter 
{ file of numbers 

{ codes for attributes 

Answers 

performers= array[ male .. female, drama .. dancing, ageless13 .. age0ver60] 
of integer; 

var 
guild: performers; 

a. 
Writeln(guild[male, comedy, age36_ 45]); 



b. 

c. 

d. 

answer :=0; 
for talent :=drama to dancing do 

for age := age26_35 to age0ver60 do 
answer:= answer+ guild[female, talent, age]; 

Writeln(answer); 

answer:= O; 
for sex:= male to female do 

for age := ageless13 to age0ver60 do 
answer:= answer+ guild[ sex, singing, age]; 

Writeln(answer); 

answer :=0; 
for sex:= male to female do 

for age := ageless13 to age18_25 do 
answer:= answer+ guild[ sex, dancing, age]; 

Writeln(answer); 

9. Subscript in Writeln should be [(ctr mod 5) + 1]. 

Chapter 12 

669 

1. A record is more appropriate than an array when you want to store more than one 
type of data in the same compound variable. 

2. Several answers are possible; note that not all need records. 

4. a. legal; b. illegal (expects a string); c. legal; d. illegal (variable name, not type, 
should be in with statement); e. illegal (total is a string in second); f 
illegal (records are of different types); g. illegal (real is not a field name). 

6. a. illegal (cannot assign records of different types); b through e are all legal 

7. a. incorrect (locType should be location); b. correct; c. incorect (houseNum 
is not an array, so it cannot take an index; street[ctr] will print an individual 
character); d. incorrect (locType should be location); e. incorrect (record 
names missing; also same problem as c);f correct 

Chapter 13 
1. type 

colors= (Ivory, Orange, Yellow, Blue, Green, Red); 
rubik = array[1 .. 3, 1 .. 3, 1 .. 3] of colors; 

2. Integers (2 .. 10) cannot be used in enumerated type 

3. The original value of curFrame 
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4. Real numbers are treated as if there was no definite interval between them. Thus, 
we do not have "consecutive" real numbers. 

5. [ ], [Dull], [Ok], [Exciting], [Dull, Ok], [Dull, Exciting], [Ok, Exciting], 
[Dull, Ok, Exciting] 

6. < set 1 > - <set 2 > yields an empty set when < set 1> is equal to < set 2 >; the 
maximum size of the difference is the size of< set 1 >. 

7. Prints output as follows: 
The number 1 place finisher is < winner[Gold] > 
The number 2 place finisher is < winner[Silver] > 
The number 3 place finisher is < winner[Bronze] > 

8. a. [Elvis, Platters, Fats, Beatles, Stones, Dylan, Springsteen]; b. [Stones, 
Dylan]; c. FALSE; d. [Supremes, Beatles, Stones, Dylan, Springsteen]; 
e. [Supremes, Platters];! FALSE; g. FALSE; h. [Supremes, Bangles]; i. TRUE; 
j. TRUE 

10. A boolean can be used as a tag field because it is an enumerated type and is thus 
ordinal; a set and a real cannot be used as a tag field because they are not ordinal 
types. 

Chapter 14 

1. Any element in an array can be accessed immediately (if you know the subscript); 
elements in linked lists must be accessed sequentially. When inserting 
infonnation into an array, you are limited by the size of an array; a linked list 
can have any number of nodes. If the infonnation is being kept in sorted order, 
you have to move a number of items in an array when you insert or delete any 
element; in a linked list, the only elements that are affected by insertion or 
deletion are the node's neighbors. 

2. The statement is not legal because ptTolnt is a pointer not an integer. To correct 
it, we can use the statement ptTolntA := 750;. 

3. A dummy header node makes insertion into a sorted linked list easier because the 
same algorithm can be used to add all elements. Without a dummy header, a 
different algorithm would have to be used to add the first node in a list. 

4 current . ~ 1G:fHBo@-iP:erl 
G 



6. If cu"entA.name = headA.name, it is not necessarily true that cu"ent = 
head. (The two pointers could be pointing at different nodes with one equal 
field.) The converse, however, is true. 

9. Change prevA.name to prevA.nextA.name in while condition; switch last 
two assignment statements. 

10. 

incubation Time 
otherltems 

next 

Chapter 15 

diaglist 
[max Diseases) 
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1. Some procedures that would be useful to call: the procedure that returns the menu 
option selected by the user; the procedure that makes some options turn gray; the 
procedure that highlights the option when selected. 

2. Two possible representations (others are possible): an array of records, where each 
record contains the title, author, and call number for a book, or a linked list of 
records, where each record contains the title, author, and call number, plus a 
pointer to the next book in the list. 

5. Not possible; if 1 is first in, it must be first out. 

6. A, B, C, D, E (final Dequeue causes error message, since no elements are left) 

7. Push 1, Push 2, Pop 2, Push 3, Pop 3, Pop 1, Push 4, Pop 4 

8. The 2 is pushed on top of the 1; therefore, the 2 must be popped before the 1 can 
be popped. It is not possible to pop something buried in the stack until 
everything above it has been popped. 

9. A, C, D, B, E (final Pop causes error message, since no elements are left) 
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Chapter 16 
1. 100.08 

2. When dtzys= 0. 

3. (Uses same function and local variable declarations.) 
begin 

newBal := balance; 
for ctr := 1 to days do 

newBal := newBal * (1 +intRate/365) 
end; { Compound} 

4. div 

5. Function returns the value 5. 

Answers 

6. Two things: eliminate the var in front of the declaration of level and, so the 
routine works even for empty trees, add the condition if current <> nil then 
after the procedure's begin and enclose the current procedure body inside 
begin/end brackets. 

7. Each recursive call must involve simpler arguments so that the problem becomes 
successively simpler, and the recursion must eventtially bottom out. 

8. In forward order: In reverse order: 

chicken 

/ "' alligator cow 

"' cat 

/"' 

cattle 

/ "' bee cow 

alligL ~tch~ 
bee cattle 

9. In a linear list, the worst case is looking at 35 items; the average case is looking 
at 35/2 or 17 .5 items. In a balanced binary tree, the worst case is looking at 6 
items; the average case is looking at log2 35, or 5.1 items. 

10. And in the end, we find the beginning. 
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Abs, 632 
Absolute coordinates, 93 
Abstract data type, 553-587, 589, 621 

concrete representation, 555, 582-583 
operations, 582 

Abstraction,463,554-555,560 
Activating windows, xx-xxi 
Actual parameters, 197-200 
Add File ... , 23, 640 
Add Window, 17, 19, 23, 640 
Address, in memory, 512, 513, 544 
Algorithms, 25,553,589 

analysis of, 609--610 
and, 139-140, 150-151 

evaluation, 140 
truth table, syntax box, 139 

Apostrophes, 15, 288, 289 
Apple menu, xxiii. 
Applicability, in user interface, 361, 362-363 
Application, building, 327 
Arc, 95, 97-98, 101, 111, 116 
Arctan, 633 
Argument, 57, 193, see also Parameter 
Arithmetic 

expressions, 84 
functions, 632--633 
integer operators, 44 
real operators, 51 

Arithmetic-logic unit (ALU), 4 
Array, 397-446,447,477,509,516, 560, 

575-579, 597 
binary search, 607 
bounds, 399 
bugs, 416-418 
declaration, 400, 484 

syntax box, 401 
elements, 399 
index, 400, see also Subscript 
insertion and deletion, 510 
multi-dimensional, 421-436 

declaration, 423 
syntax box, 423 

ranges, 422 
characters, 398 

one-dimensional, 397-421 
out-of-bounds error, 416 
parallel, 418-420, 436 
as parameters, 436 
random access, 401 
range, 399 
of records, 450, 452-456, 461-468, 469, 511 
searches, 414-416 
sending elements as parameters, 417-418 
sending whole thing as parameter, 417-418 
sequential access, 401-403 
subscript, 400, 418-420, 436 
vs. binary tree, 610 
vs. linked list, 582 

ASCII, 290, 480, 485, 501 
Assignment, 49-50, 53, 84, 201 

boolean, 133 
char 288, 297 
fields of records, 449, 450-451 
function , 210, 211, 632 
from mouse I 08 
nil pointer, 526 
operator ( := ), 49 
pointer, 520, 522, 526 
record,450-451,497-499 
reel, 104 
set, 484-485, 491-492 
set members, 50 I 
string, 291, 297 
syntax box, 50 
variant records, 497-499 

Assumptions about user, 34, 362 
Atomic data types, 397, 447, 477 
Attitude, of professional programmers, 360 
Attribute, 99-104, 116 

pen, 99, 100 
see also Paint, Erase, Invert, Frame 

Autl>--Save, 19, 640 
Autl>--Show Finger, 640 
Average case, 609--Q I 0 

673 



674 

Back end, 245 
Balanced trees, 608 
Bar graph, 156 
Base type, of sets, 484, 493 
begin, 13 
begin/end brackets, 29, 126, 130, 143, 147, 

164, 173, 181, 183, 372, 457, 496 
Binary choices, 123 
Binary code, 5, 289, 313 
Binary search, 596-597, 607 
Binary tree, 589, 596-622 

advantages, 597, 608--610 
array implementation, 627 
balanced, 622 
building, 597--601, 621 
degenerate, 599, 622 
deleting from, 625 
hand simulating building, 603--605 
height, 599 
implementation, 600--605 
initializing, 601--602 
printing, 610--619 
and recursion, 610--622 
searching, 605-610, 622 
terminology, 597 
vs. array, 610 
vs. linked list, 610 

Bit, 5, 322, 513 
Black box, 240 
Blank disk, xxiiii 
Blank lines 

in output, 28, 362 
in programs, 15 

Blank character, 64, 291, 290, 300, 315 
in input, 332 
trimming from strings, 308-309, 311 

Block comment, 257 
Block of statements, see begin/end 
Boldface,in pretty printing, 629 
Bomb, 141, 239, 337, 400, 554, 601 
Boolean, 123, 133-134, 479 

condition, 133, 184 
constant, 133 
data type, 123 
expression, 150, 493 
expressions, evaluation, 140 
expressions, shorthand, 134 
function 169 
operators, chaining, 140 
operators, priorities, 140 
operators, see Logical operators 
variables, 133-134, 150 

Bottom out, of recursion, 593, 611, 621 
Bottom-up design, 281 
Boundary conditions, 168, 182, 185 

of linked lists, 533-534 
of loop, 179 

Branching, 124 
Break at A-Traps, 641 
Browser, MacPascal tool, 324 
Bug spray can icon, 180 

Bug, 18,80, 185,207 
locating, 267 
box, 18, 72, 271 
see also Syntax error 

Build & Save As .. ., 327, 640 
Build, 9, 640 
Building project, 327 
Button, 169, 635 
by Date, xxiii 
by Icon, xxiii 
by Kind, xxiii 
by Name, xxii 
by Size, xxiii 
by Small Icon, xxiii 
Byte, xi, xvi, 5, 513 

CALL: notation, 249 
Call by reference, 206 
Call by value, 206 
Capitalization, 30 
Cardinality, of sets, 484 
Caret sign("), 515, 518 
Case (upper vs. lower), in programs, 629 
case, 141-145, 151, 159, 184, 239, 288, 501 

example, 143-145 
flow of control diagram, 142 
multiple values of selector, 145 
selector, 151 
syntax box, 143 
vs. if-then-else if, 149 
in variant records, 495, 496 

Index 

Central processing unit (CPU), 3, 4, 5, 38, 322 
Chaining, 

arithmetic operators, 235 
set operators, 491 

Chapters, format of, ii-iii 
Character, 142, 287, 433, 513, 652 

in array range, 399 
assignment, 288 
char data type, 287, 288, 313, 501 
collating sequence, 290, 294, 483, 652 
comparison, 289-290 
declaration, 288 
input, 288, 289 
inside string, 297, 313 
order of, 290, 294, 483, 652 
in ordinal functions, 483, 633 

Check, 267, 638,640 
Check Link, 640 
Checkmark, in menu, xxiii 
Child node, in binary tree, 605 
Chr, 633 
Circles, drawing, 116, 193-200 

see also Ovals 
Clarity, 362, 366, 390 
Clean up, xviii, xix 
Clear, Pascal Edit menu, 637, 639, 646 
Clear, Text Editor Edit menu, 328 
Clicking, mouse action, xiv 
Clipboard, 644--646 
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menu option, Pascal Windows menu, 638, 
641 

menu option, Text Editor Windows menu, 
329 

see also Copying, Cutting, Pasting 
Clipping, 92-93 
Close (Pascal statement), 344 

syntax box, 343 
Close menu option 

Desktop File menu, xxi 
Pascal File menu, 21, 637, 639 

Close box, xv, xvi, xxiii, 21 
Close Project.", 10, 22, 640 
Closed objects, 373 
CloseRgn, 372, 391, 635 

syntax box, 375 
Cloverleaf key, 651 
Code, 37, 255-257 

efficiency, 589 
graphics, 256-257 
recursive, 593-595 
revising, 276 
rewriting, 269 

Code examples 
function Binary (binary search in array), 

607-608 
procedure AddNode, 600--601 
procedure AddNode, (recursive), 619--620 
procedure DrawGraph, with repeat, 178 
procedure DrawGraph, with while, 176, 

177 
procedure DrawPolygon, 204-205 
procedure FormLetter, 295-296 
procedure GraphResults, 106, 121 
procedure lnifl'ree, 601-602 
procedure SaveShape, 499-500 
procedure Search (for binary tree), 606 
procedure Search (recursive), 620 
program Boat, 382-387 
program Calculator (with bugs) 257-266 
program Calculator, final mainline, 278 
program Club, 537-544 
program Doghouse, 148-149, 169-171 
program ExplodeWedge, 115 
program Faces, 35-36 
program Fence, 216-223 
program IceCream, 61 
program IceCreaml, 73-74 
program Inventory, 410--413 
program Layout (with Undo), stack user's 

view, 570-573 
program Mailing, 643--644 
program Reservations, 429-436 
program Scoreboard, 345-347 
program Soap, 464-469 
program Waitlist (user's implementor), 

564-566 
program Waitlist (user's view), 558-560 

Collating sequence, 290, 294, 483, 652 
Commas, in declarations, 48 

Comments, 12 
see also Documentation 

Communication links, 192 
Comparing, time of algorithms, 609-610 
Comparison, 123, 149, 150 

character, 289 
characters and strings, 313 
enumerated types, 480--484 
integers and reals, 125 
mutually exclusive, 149 
numeric, 124 
operators, 150, 289 
pointers, 521 
string, 293-294, 313, 601 
symbols, 125 
syntax box, 125 

Compatible types, 125 
Compiler, 5, 38, 267 
Complement, of set, 490 
Component, file, 322, 331, 348 
Composite/Compound data types, 397, 436, 

447,469 
accessing single element, 455-456 
in memory, 513 

Compound statement, 29, 143, 164, 183 
Computer onion, 6, 23 
Concat, 299-301, 313, 633 

syntax box, 300 
Concrete representations, 463, 555, 582-583 
Conditional branch, 124, 126, 147 
Confirm Saves, 19, 640 
Confirmation, 364-365, 391 
Consistency, 361-362, 366, 390 

in graphics, 366 
const, see constants 
Constant, 45, 68-71, 84, 257, 260, 313, 360, 

400 
declarations, 69, 406 

syntax box, 70 
predefined, 69 
set, 487 

syntax. box, 487 
symbolic, 68 

Containment, in sets, 494 
Coordinate system, 92 

absolute, 93 
Drawing window, 54, 116 
relative, 93 
screen, 367-368 

Copy menu option 
Pascal Edit menu, 637, 639, 644 
Text Editor Edit menu, 325, 328 

Copy string function, 301-304, 309, 313, 633 
diagram, 303 
syntax box, 304 

Copying 
files, xxi, xxiv-xxv 
parts of files, 325-328, 644-646 
see also Pasting 

Correspondence, one-tcr-one, 193 
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Cos, 632 
Counter, loop, 160 
Crash, see Bomb 
Creativity, 281 
Current file position, 322, 329, 332, 337, 342, 

348 
Current position (CP), in QuickDraw, 57, 93, 

109 
Cursor, xiii, 13 
Cut 

Pascal Edit menu, 637, 639 
Text Editor Edit menu, 325, 328 

Cutting, parts of files, 325, 328, 637--639, 646 

Data abstraction, 463 
Data file, 323-340 

choosing, 334-335 
creation, 328--329 
order, 330 
printing, 324 

Data management, 513 
Data structure, 553, 589 

pseudocode,428,461-464 
Datatype,47, 84, 133-134, 195,449 

abstract, 553-587 
atomic, 397 
char, 287, 288 
composite/compound, 397, 436, 477-508 
field of record, 451 
graphic, 104-108 
integer, 47 
predefined, 629--630 
real, 47, 51-54 
returned by function, 211 
string, 291 
see also Abstract data type, Type 

Debug menu, 80, 83,641 
Debugging, 33,44, 74-83, 233, 235, 267-282 

strategies, 269 
where to start, 270 
with stubs and drivers, 279--281 

Declarations, 3, 255, 398 
array,400-401,484 
array of records, 453 
char, 288, 313 
constants, 69 
enumerated types, syntax box, 480 
file variables, 329--330 
functions, 211 
local variable, 196 
in memory, 533 
multi-dimensional arrays, syntax box, 423 
order of variables, 52 
parameters, 193--196, 200-202 
pointer variables, 515-516, syntax box, 515 
records, 449 
records, syntax box, 451 
set, 484, 
string, 291, 313, syntax box, 292 
syntax box, 486 
type, 405-408 

variables, 46, 83, 191, 371 
location of, 47 
syntax box, 47 

variant records, syntax box, 496-497 
Defining problem 235-237 
Definite loop, 184, 239 

see for 
Definitions, 3 
Delete ... , 22, 639 
Deletion 

from binary tree, 625 
from linked lists, 532, 535-536, 544 
from ordered array, 510 

Delimited, 288 
Dequeue, 556-557, 562-564, 583 
Desk accessories, xxiiii 
Desktop, xii, xvii, 322, 554 
Dialog box, xxiv 
Difference, of sets, 488 

syntax box, 491 
Disk, xi, 2, 3, 4, 322, 349 

copying files between disks, xxiv-xxv 
ejecting, 651 
initializing, xxiv 
memory on, xvi 
naming, xxiv 
opening, xxiv 
removing from disk drive, xxiii 
start-up, xii 
using second, xxiii-xxv 

Dispose, 532-533, 581, 633 
syntax box, 533 

DisposeRgn, 379, 532, 635 
syntax box, 379 

Disposing files, xxi-xxii 
Distance formula, 203 
div, 44 
Divide and conquer, 24 
Division of reals (/), 51 
Do It button, 270 
Documentation, 33,38,255, 257, 359--360 

block comment, 34 
syntax box, 34 

external (exDoc), 379-382 
example, 387-390 

glossary, 48, 84, 213, 223, 255, 515 
header comment, 35 
inline comments, 34 
internal, 380 
of functions, 213 
of parameters, 213 
purpose, 34 
variables, 48 
pointer variables, 515 

Don't Save, 19, 640 
downto, 183 
Dragging, xiv, xvi 
Drawing menu option, 54, 638, 641 
Drawing window, 12, 54, 84, 116, 366-368 

size of, 54-55, 93 
DrawLine, 116, 635 

Index 
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Drivers, 279, 280-281 
Dummy node 

creating, 525-526 
in binary tree, 601, 603 
in linked list, 522-523, 525-526 

Duplicate, xxi 
Dynamic storage, 509, 510, 516 

:Echo print, 294 
Edit menu 

DeSktop , xvii, xxii 
Pascal, 639, 646 
TextEditor,325,328 

Editing, 11, 12, 13, 39 
changing text, 14 
deleting text, 14 
finding text, 646-649 
highlighting, 14 
~rting text, 15 
replacing, 646-649 
selection, 14 
time-savers, 642-651 

Editor Project, 327 
Efficiency, 589, 609-610 
Ego,268 
Eject, xxiii, xxv. 651 
Elements 

of an array, 399, 400, 477 
of compound data structures, 452, 455-456 

else, 129-132, 145 
Empty Folder, xx 
Empty rectangle, 113 
Eµipty set, 487, 492 
Empty stack, 569, 574 
Empty string, see Null string 
Empty Trash, xxii 
end, 13, 32 

reeord, 449 
case, 143. 

. see begin/end bracket!! 
End of variant records, 496 
Enqueue,556-557,561-563 
Entrance, loop, 179 
Enumerated types, 477-484, 501 

and constants, 481 . 
declaration, syn~ box, 480 
ellOr message, 479 
in ordinal functions, 480-484 
input, 479 
numbering of, 480 
order, 480-484 
output, 479-480 

Eof function, 337-339, 350 
syntax box, 337 

< eof > marker, 330, 337-339, 349-350 
Eoln function, 339-340 

syntax box, 340 
< eoln > marker, 330, 339, 343, 350 

and strings, 333 
in input, 332 

Equality, 125, 492 
see also Comparisons 

Erase attribute, 102-103, 117, 373, 374, 636 
EraseArc, 102-103,636 

syntax box, 102 
EraseOval, 102-103, 636 

syntax box, 102 
EraseRect, 102-103, 636 

syntax box, 102 
EraseRgn, 374-376, 391, 636 

syntax box, 377 
EraseRoundRect, 102-103, 636 

syntax box, 102 
EllOr inessages, 

function, 212 
pliraineters,207,208 

EllOrs, 
arithmetic,. 269 
checking, 365 
conditions, 239 

in.exDoc, 381 
off-by-one, 269 
semantic, 267 
see also Syntax C110rs . 

Everywhere menu option, Search menu, 638, 
6474i9 
ExJ)oc, see Documentation, external 
Exclusive or, 227 
Exit condition, 160, 168-174, 179-181, 184 
Exit, from program 363 
Expressions, arithmetic, 45, 53, 84 

Factorial, 593-595 
FALSE, 123, 150 
Fibonacci series, 403-405 
Field (in output), 63 

specification, 63, 84 
width, 64, 84, 294, 343, 480, 634 

Field (of record) 
i!CCCSSing, 449, 458, 477 
accessing via pointer, 518 
in array of records, 450 
as parameter, 452 
in variant record, 484, 497, 502 
in with, 458-461 
fixed, 477 

FIFO (first in, first out), 555 
File menu 

Desktop, xvii, xx-xxi 
Pascal, 20-23, 639 
Text Editor, 329 

File System, 6 
File, xx-xxi, 6, 321-357 

access to, 401 
buffer, 329, 350 
component, 322, 329 
current file position, 322 
data, printing, 324 
defined, 322 
< eof > marker, 330, 337 
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< eoln > marker, 330 
input, 330-340 
movement of current file position, 332 
numbering components, 322 
order of data, 330 
output, 341-344 
random access, 323 
read-only, 322 
read-write, 322 
resetting, 331 
separate modules, 560 
sequential access, 323 
status, changing, 348 
variables, 321-357 
write-only, 322, 341, 342 
saving, 17, 19--20 

Find, Edit menu, LS, 638, 639, 647-648 
Find What ... , 639, 646 
Finder, x, 6 
Finding text, 646-649 
Fixed fields, 494, 497 
Flag, 134, 139, 170 
Floppy disks, see Disks 
Flow of control, 123-190, 197-200, 457 

abstraction, 463 
constructs, 259--260 
diagrams, explanation, 127 

Folders, xx, 7 
Font Control ... 

Pascal, 638, 649 
Text Editor, 329 

for, 159--168, 183-184,478,501 
and array, 402-403, 420 
backwards, 183 

syntax box, 183 
enumerated types as limits, 481 
flow of control diagram, 161 
hand simulation, 160-162 
nested, 163-168 
syntax box, 164 
vs. repeat-until, 168 
see also Definite loops 

Fonnal parameter, 197-200, 206 
Fonnal parameters, see Parameters, fonnal 
Formatting output, 63, 313 

examples, 65 
Frame, attribute, 95--99, 117, 636 

FnuneArc,98,301,636 
syntax box, 98 

Franie<Jva~95-JJ7, 194,373,636 
syntax box, 96 

FnuneRect, 95-96, 193, 373, 636 
syntax box, 96 

FnuneRgn,374-376,391,636 
syntax box, 377 

FnuneRoundRect, 99, 373, 636 
syntax box, 99 

Front end, 245, 369 
Frustration, 269 
Fully qualified name, 450 

Functions, 191,209--213,223 
assigning final value, 210, 632 
calling, 210 
data type returned, 209, 223 
declaration, 209--210, 211, 212 
error messages, 212 
input and output, 634-636 
MacPascal-11pecific, 630 
nested, 632 
parameters in, 209--213 
predefined,52,201,630--633 
QuickDraw, 631 
QuickDraw2, 631 
recursive, 620, 621 
syntax box, 211 
use of temporary variable, 212-213 

Garbage value, 49, 84, 201, 291, 517 
Generic menu, 243 
GetMouse, 108, 117, 136, 168-169, 200, 

267, 635 
syntax box, 108 

Global declarations, 69, 87, 407 
Global replacement, 648-649 
Global variables, 407 
Glossary, 48, 84, 213, 223, 255, 515 
Go, 18, 269, 282, 638, 640, 651 
Go-<io,80,269,638,640 
Grammar, 2 
Graphic data type, 104-108, 114, 116, 371, 

635 
comparisons, 149 
internal representation, 114 
see also point, rect, regions 

Graphics, ii, 56-60, 70-71, 74-84, 91-122, 
160, 176-179,360 
primitives, 56-60 
procedures and functions, 635-636 
pseudocode, 253 
rules on Macintosh, 93 
see also QuickDraw 

llali menu option, 180 
Hand simulation, 127-129 

advice, 83 
of binary tree building, 603-605 
of code, 74-83 
key questions, 73 
of Layout (with Undo}, 573-575 
of linked lists, 525-530, 533 
of printing binary tree, 612-619 
in program development process, 234 
pseudocode, 72 
of recursion, 612-619 
while, 179 

Hard copy, 5, 650 
Hard disk, xi 
Hardware, ix-x, 2 
Head pointer, 522, 525-530, 544 
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Height, of binary tree, 599, 608 
Help facility, 365 
Hexadecimal notation, 513 
HillePen, 373, 635 

syntax box, 375 
Highlighting, xiv, 14, 103 

uo. 321 
Icon, xii, xv, xviii, 322 
Identifier, 46, 216, 360, 629-631 

creating, 360 
length of, 46 
parameter, 216 
predefined, 629-631 

if-then, 126-151, 159, 184 
evaluating, 127-129 
flow of control diagram, 127 
nesting, 128-129 
syntax box, 126 

if-then-else, 130, 133, 150 
flow of control diagram, 131 
hand simulation, 130-131 
syntax box, 130 
vs. if-then, 132 

if-then-else if, 145-150, 239 
flow of control diagram, 146 
syntax box, 146 
vs. case, 149 

Implementor's view, 560-566, 581-583 
in co<fe. 564-566 
vs. user, 381-382 

in, 492-494 
syntax box, 494 

Include, 305-307,633 
Indefinite loop, 168, 170, 174-179, 184, 239, 
414, 619 

multiple exits, 184 
see also while, repeat-until 

Indentation, 16, 126, 129, 649-650 
Index, of array, see Subscript 
lnduction,533,594 
Inequality, 125 
Infinite loop, 173, 179-181 

stopping, 180 
Input, 3, 38, 44, 49, 159, 267, 331-340, 634, 

635 
documenting in exDoc, 381 
enumerated types, 479 
file buffer, 329-330, 331, 335 
from keyboard or file, 335 
from keyboard, 321 
graphic, 108-109, 116, 635 
num~c. 66-68 
of numbers from files, 332 
reading_ from files, 331-340 
of sets, 491 
of strings from files, 333 
telling user what to expect, 361 
to building binary tree, 599 
see also Read, Remlin 

Input-processing-<>utput sequence, 3-6, 83 

Insertion, 
into linked lists, 522, 525-532, 535 
in binary tree, 600-601, 603-605 

Insertion point, 11, 13 
lnsetRect, 112-113, 635 

syntax box, 113 
lnsetRgn, 377, 635 

syntax box, 378 
Instant menu option, 638, 641 
Instant window, 270, 272-274, 281, 282 
Integer, 44-56, 84, 141, 322 

coordinates, 116 
operators, 44, 84 

syntax box, 44 
in ordinal functions, 483 
output of, 63-64 
range of representation, 47 
reading from files, 332 
use in graphics, 92, 93 

Internal representation, 245 
Intersection of sets, 488-489, 501 

syntax box, 491 
Invert attribute, 103-104, 116-117, 373, 374, 

636 
lnvertArc, 103-104, 636 

syntax box, 104 
lnvertCircle, 116, 636 
lnvettOval, 103-104, 636 

syntax box, 104 
lnverlRect, 103-104, 636 

syntax bOx, 636 
lnverlRoundR.ect, 103-104, 636 

syntax box, 636 

Key, in search, 414, 605 
Keyboard, xi, 2, 3, 331-332, 335 
Kilobyte, xvi, 513 
Knowledge, expectations about user, 363 

Language, high-level, 2 
Last in first out (LIFO), 566, 583 
Law of least astonishment, 390 
Layout, 156, 189, 202-207, 213, 445-446, 

459-461,494-501,551,567-582,585 
Leaf node, 597 
Ledgard, Henry, 359-360 
Left child, in binary tree, 597 
Length,299,309,313,633 

syntax box, 299 
Lexical scope, 406-407 
LIFO (last in first out), 566, 583 
LightsBug, 641 
Lightspeed Pascal, i, x 

differences with MacPascal, 7 
getting started, 8 
program in multiple files, 560 

Limit (of a loop), 160 
Limit case, 593 
Line, 

drawing, 57, 116, 160 
part of region, 373 
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Line graph, 230-231 
Line, (QuickDraw statement), 93-94, 116, 373, 

635 
syntax box, 94 

LineTo , 56-59, 92, 93116, 373 635 
syntax box, 59 

Linear search, 608-610 
Linked list, 397, 509, 511-512, 522-544, 560, 

597, 599 
boundary conditions, 533-534 
deletion of nodes, 532, 535-536 
dummy node, 522 · 
end of, 523 
example code, 524, 534-544 
hand simulation, 525-530 
head pointer, 522 
insertion of nodes, 522, 527-532, 535-536 
representing stack, 579-582 
vs. array, 582 
vs. binary tree, 610 

Lists, 397 
Literal constants, 44, 84 
Literal string, 27, 290 
Ln,633 
Local scope, 407 
Local variables, 48, 191, 195-196, 201, 255 
Logical operators, 137-141, 150-151, 184, 

227 
LOGO, 550 
longint, 48, 84, 349 
Lookup table, 426-427 
Loop, 108, 159-190 

body, 160, 173 
counter, 160 
definite, 160 
entrance, incorrect, 181 
errors, 179-183 
and file input, 336 
indefinite, 168, 336 
nested example, 163-168, 181 
nested for, 163-168 
parts of, 185 

Lower limit, loop, 160 
LPl .System disk, 8 
LP2.Libraries disk, 8 
Ltrim, 308, 311,337,538 

Machine code, 5 
Macintosh, i 
MacPaint, 322 
MacPasLib, 9, 10 
MacPascal, i, x 

debugging facilities, 267 
differences with Lightspeed, 7 
getting started, 7 

MacPascal-specific procedures, 630 
Macsbug, Debug menu, LS, 641 
MacTraps, 9 
Mainline, 28, 32 
maxlnt. 70 
maxLongint, 70, 349 

Membership, in sets, 492-494 
Memorization, user's, 366 
Memory, xi, xvi, 3, 4, 38, 46, 206, 291, 322, 

511,513,515,532-533,544,633 
Memory manipulation procedures, 633 
Menu, 134-136, 159, 185, 213, 239, 391 

bar, xiii, xvii-xix, 367 
button, 297 
choosing option, xviii 
generic, 171 
options, 365-366 
pull-down, xix 
Pascal, 637-641 
Macintosh, 366 
textual, 288 

Merge sort, 353 
Microprocessor, 2, 4 
Minimum number, 188 
Mnemonic names, 49, 360, 516 
mod, 44, 51, 126 
Modifications, documenting, 381 
Modularity, 407 
Mocjule 

in abstraction, 554, 582 
module interconnection diagram, 381, 390 
module specifications, 39 l 

Mouse, xi, 2, 3, 108 
actions, xiii-xiv 
clicking, xiv 
double-<:licking, xv 
dragging, xiv 
input, 136 
moving, xiii 
pointing, xiv 
stroking, xiii 

llfove,93-94, 109, 116,635 
syntax box, 94 

llfoveTo, 56-57, 92, 93, 116, 635 
syntax box, 57 

Moving files, xxi-xxii 
Moving objects, 109-111, 117, 377-379 
Multi-dimensionat arrays, 421-436 

declaration, syntax box, 423 
elements in, 423 

Music layout, 120, 231 

Naming variables, 84 
Nesting 

functions, 302, 632 
if, 128-129 
loops, 163-168, 181 

New Folder, xx 
New Project .. ., 8-9, 640 
New menu option, 11, 22, 637, 639 
New procedure (pointers), 516-520, 532, 533, 

544,633 
hand simulation, 525 
syntax box, 517 

NewFileName, 341-342, 350 
syntax box, 342 

NewRgn, 371, 391, 532, 635 
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syntax box, 371 
nil pointer, 5ll, 521-523, 526, 544, 561, 

581, 600, 611 
error in accessing fields, 522 

Node, 
creating, 525-530 
in binary tree, 597 
in linked list, 511 

not, 137-138, 150 
truth table, syntax box, 138 

Notations, used in this book, vii 
Null character, 294 
Null string, 290, 334 
Number crunching, 43, 287 
Numbers, 43--85 

Observe menu option, 75, 638, 641 
Observe window, 74-83, 160-168, 180, 198, 

269, 271 
Odd, 632 
Off by one error, 174, 182-183, 185, 269 
OffeetRect, 109-lll, ll7, 635 

syntax box, llO 
OffsetRgn, 377, 378, 391, 635 

syntax box, 378 
Offsets, 70 
OldFilelVanie,334--335,341,350 

syntax box, 335 
Olllit,304--306,313,633 
One-dimensional arrays, see Arrays 
One-to-one correspondence, 193 

figures, 199, 206 
One-way parameters, see Parameters, value 
Onion,computer,6,23 
Open ... menu option, 21, 334, 637, 639 
Open Project. • ., 21, 22, 640 
Open (Pascal statement), 337, 348-350 
OpenRgn,372,391,635 

syntax box, 374 
Operating system, 6 
Operations, on abstract data type, 582 
Operators, 

boolean, 140 
integer, 44 

or, 138-139, 140, 151 
evaluation, 140 
truth table, syntax box, 139 

Ord,482-483,501,503,633 
syntax box, 483 

Ordered lists, 510 
Ordinal functions, 633 

syntax box, 483 
Ordinal number, 480, 482, 501 
Ordinal type, 141, 149, 151, 288, 313, 

482-483,497,399,402,501 
Origin (0, 0), 55 
otherwise, 144, 145 
Output, 3, 38, 321, 634, 635-{i36 

blank lines, 362 
clarity, 362, 390 
devices, 4 

file, 329-330,341-344 
syntax box, 343 

graphic, 91-117 
text, 13 

syntax box, 28 
variables, 6~. 84 

syntax box, 66 
Ovals, 95, ll6 

degree marks, 97, 98 

Page Setup ... , 22, 637, 639 
Paint attribute, 100, 116, 117, 373, 374, 636 

PaintArc, 101, 105,636 
syntax box, 100 

PaintCircle, 116, 636 
Paint<Jval, 100,636 

syntax box, 100 
PaintRect, 100, 163-168, 636 

pseudocode, 163-164 
syntax box, 100 

PaintRgn, 374--376,391,636 
syntax box, 377 

PaintRoundRect, 100, 636 
syntax box, 100 

Parallel arrays, 418-420, 447-448 
declaration,418,419 
in record, 464-468 

Parameters, 57, 191-223 
actual, 197-200 
array, 405, 408 
checklist for passing, syntax box 209 
data type, 195 
declaration, syntax box, 196 
determining in pseudocode, 255 
expressions, 197 
fields of record, 452 
formal, 197-200 
to functions, 209-213 
list, 196, 211 
matching, 207, 210, 223 
naming,216 
number, 207, 210, 223 
order of, 197, 208, 210, 223, 269 
passing, 193, 198-199, 208, 594--595, 632 
problems, 207 
program, 329-330 
record, 451-452 
in recursive code, 594--595, 619, 620, 
6ll-619 
in stubs, 280 
semantic error, 208 
sending arrays, 417-418, 436 
sending elements of array, 417-418 
type of, 210, 223 
value, 223 
value vs. variable, syntax box, 20 l 
variable, 223 
vs. local variables, 195 

Paranoid programming, 239, 365 
Parent node, in binary tree, 597 
Parsing, 301 
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Pascal, i, 2, 38 
Paste menu option 

Pascal, 637, 639, 644, 645 
Text Editor, 328 

Pasting, 
parts of files, 328, 644-646 
see also Copying, Cutting 

Pause menu, 180 
Pen,57, 84,92 

manipulations, 116 
color, 100, 101-102, 116 
pattern, 100, 101-102, 116 

PenPat, IOI, 193, 635 
syntax box, 101 

Period (.), 32, 44~50 
pi, 69 
Pick correlation, 134-136, 251 
Pie graph, 105, 230 
Pixel, 54, 55, 92, 116, 160, 215, 367, 

649-650 
point, 108, 117, 136, 473, 635 
Pointer, 507-552, 561 

accessing fields, 518, 522 
arrow representation, 514 
assignment, 520-521, 522 
chasing, 528-530 
comparison, 521 
declaring, 515-516, 

syntax box, 515 
field in reocrd, 544 
head of linked list, 522 
in main meory, 513-514 
nil, 523 
purpose in life, 512-513 
represented with caret (" ), 515 
representing in hand simulation, 525 
variables, 5 ll 
see also Linked lists 

Pointing, mouse action, xiv 
Polygon, drawing, 202-207 
Pop, from stack, 566, 574, 577, 581-582 
Pos function, 301, 303, 313, 429, 633 

syntax box, 303 
Power switch, xii 
Precision, 64, 84, 343, 634 
Pred, 481-483, 633 

syntax box, 483 
Predefined functions, 52, 53, 84 
Predefined procedure, 193, 516 
Preferences ... , 341, 638, 650-651 
Pressing, mouse action, xiv 
Pretty printing, 16, 18, 19, 33, 38, 48, 72, 

126, 128, 649-650 
boldface, 11, 629 
identifying errors, 16 
indents, 649-650 
tab, 649-650 

Primitive objects, 56--60, 95, 116, 369 
Print. • ., 22, 637, 639 
PrintTextFiles, MacPascal tool, 324 
Printer, xi, 4 

Printing 
output, 650 
Pascal files, 22 

Priority of operators, 44-45, 51, 84, 491 
Problem solving, i, 1, 24-27, 233, 235-237, 
463, 589 

breakdown, 46~70 
decomposition, 234 
definition, 235-237 
number of ways to solve, 242 

Procedure,28,38, 192, 193,589-590 
abstraction, 463 
call with parameters, syn. box. 200 
calling, 31, 593 
declaration, 29, 199 

syntax box, 30 
with value parameter, syn. box. 196 
with value and var parms, syn. box. 202 

effect, 240 
examples, see Code examples 
generalizing,241 
input and output, 634-636 
invoking, 31, 593 
MacPascal-specific, 630 
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parameters in declaration, 193-196, 200-202 
predefined, 193, 630-631 
pseudocode, 237, 240-241,249, 282 
recursive, 595, 612--019, 621 
requires, 240 
returns, 240 
standard Pascal, 630 
use of, 200 
vs. functions, 209-213 

Processing data, 3 
Program,2, 38 

clarity, 68 
declaration, 12, 32 

syntax box, 32 
description, 380, 381-382 
development, 44, 60-61, 233-286 

with compound data structures, 424-429 
creativity, 281 
diagram, 234 
intuition ,281 

editing, 7 
example, see Code examples 
execution, 3-6, 7, 18,38, 282 
"good," 360 
order, 32-33 
style, 213 
testing, 267-268 

Program menu option, 638, 641 
Program window, 11, 12, 38 

changing font, 649 
Programmers, professional, 359-360 
Programming, i, 1,43 

language, 1, 2 
large projects, 554-555 
process, 43 
and writing, 391-392 

Project (Lightspeed), 8, 9, 22-23 
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adding files, 17 
creating new, 11 
window, 341 

Project menu (Lightspeed), 8, 10, 17, 22, 
270,327,640 

Project menu option, 641 
Projections, 111 
Prompt, 67, 239, 292, 335, 342, 361, 362 
Proof by induction, 533 
Pseudocode, 25, 44, 106, 113, 147, 233-257, 

282,344,424-429,469-470,642-643 
advice, 37 
applying other solutions, 243--244 
CALL:notation,249 
compound data structures, 424-429 
correlations in data structures, 426 
details in, 244 
development, 237-257 
example, see Code examples 
fitting pieces together, 248-250 
flow of control, 238-239, 243, 259-260 
generalities vs. specifics, 242 
generic menu, 171 
graphics, 253 
hand simulating, 72, 237-254 
legal statements, 238 
levels, 26 
procedures, 29, 249 
recursive, 592-593, 594 
regrouping, 237 
repetition,37,237-238,252-253 
reserved words, 37, 163-164, 239 
specific items, 238-241 
strategies, 233-257 
translating to code, 255-257 

Pseudodata structure, 462-463, 534-537 
PtlnRect, 136-137, 209, 635 

syntax box, 137 
Pull Stops, 83, 641 
Pull-down menus, 366 
Pun, bad, xiii, 97 
Punctuation, 267 
Push, on stack, 566, 573-574, 577, 579-580, 

583 

Queue,397,555-566,582-583 
dequeueing, 556 
enqueueing, 556 
implementor's view, 560--566 
operations, 557, 560--566 
order of, 556 
pseudocode,557 
user's view, 555-560 

QuickDraw,92-117, 159-168, 193,321,360 
data types, 555 
procedures and functions, 631 

QuickDraw2,370,582-583 
Quit, 23, 637, 639 

Random, 189, 227, 633 
Random access, 401, 424 

Range, 
of array, 399, 400 
of multi-dimensional arrays, 422-424 

Range of representation, 47-48, 51, 477, 479, 
481, 486, 501 
enumerated type, 479 
integer, 47 
longint, 48 
real, 51 

Raster, 54, 84, 92, 116 
Read, 

with files, 331-340, 350, 634 
syntax box, 333 

from keyboard, 44 
see also Input, Readln 

Read--0I1ly, 322, 323, 331, 348, 349 
Read-write, 322, 323, 348-349 
Readability of programs, 48-49 
Readln,44,66-68,84, 201,267,321,332, 

634 
see also Input, Read 
char, 288, 289 
from files, 331-340, 350, 634 

syntax box, 333 
string, 292 

Real,51-54, 84, 149 
comparisons, 124, 149 
declaration, 51 
mixing with integers, 52-54 
output, 64-66 
range of representation, 51 
reading from files, 332 

Records, 447-475, 561 
and arrays, 450, 452-456, 469 
declaration, 449 

syntax box, 451 
pointer field, 511, 522, 544 
to represent stack, 576 
with statement, 457-461 

reel, 104-105, 117, 136, 366-368, 555, 569, 
635 
internal representation, 109 

Rectangle, 95-96, 116 
choosing points, 154 
empty, 113 
internal representation, 112 
moving, 109-111 
specifying in graphics calls, 635 

Recursion, 589-595, 610--622 
algorithm, 590-593 
binary trees, 610--622 
bottom out, 593 
call of procedure, 595 

Redocommand,568 
Region, 360, 369-379, 391, 635 

defining, 371-374 
disposing, 379 
drawing, 373, 374-377 

syntax box, 377 
initializing, 371 
overlapping areas, 375-376 
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Regular expressions, 315 
Relative coordinates, 93 
Remove, 23, 640 
Repeat-until (bold), 108, 117, 159, 171, 

184, 185 
exit condition, 168-169 
flow of control, 169 
syntax box, 170 
vs. for, 168 
vs. while, 172, 17 4-179 

Replace, 638, 639, 647--648 
Requirements specifications, 237 
Reserved words, 16, 629-631 
Reset menu option, 638, 640 
Reset statement, 331-332, 337, 348, 349, 

3SO 
syntax box, 331 
with OldFileName, 334 

Resize box, xv 
Resizing objects, 111-113 
Responses, to prompts, 361 
Revert, 22, 637, 639 
Revising code, 276 
Rewrite, 337, 341-343, 348, 349, 3SO 

syntax box, 342 
Right child, in binary tree, 597 
Right-justification, 64 
Root node, in binary tree, 601 
Round,53, 84, 105,209 

syntax box, S3 
Rounded rectangle, 95, 99, 111, 116 
Run menu, 9, 18, 76, 80, 267 
Run Options ••. option, 640, 649, 6SO 
Run-time error, 291 

Save., 20-21, 637, 639 
Save a Copy As ... , 22, 639 
Save As ••• , 

Pascal, 19, 637, 639 
Text Editor, 328-329 

Saving files 
as application, 327 
as text, 324 
data files, 328-329 

Scaling objects, 111-113, 117, 377-379 
Scientific notation, SI , 64 
Scope, 192 
Screen, 2, 4, 12 
Screen coordinates, 367-368 
Scrolling, xvii, 6SO 

scroll arrows, xvii 
scroll bars, xvii 
scroll box, xvii 

Search menu, 302, 638, 646 
Searching, 

comparing methods, 608-610 
in data structure, 414-416 
in file, 646--649 

Seek, 348-349, 3SO 
syntax box, 349 

Select All, 328, 637, 639, 646 

Selection 
editing, 14 
of icons, xiv 

Selector, multiple values, 14S 
Selector, of case, 141, 143, 14S, ISi, 288 
Semantic errors, 72, 208, 267 
Semicolons, IS, 201, 202 
Sentinel, IS9, I 7S, 178, 230 

< eof > marker, 337-340 
< eoln > marker, 339-340 

Sequential access, 323, 401-403, 424, S97, 
610 

Sequential search, 414-416 
Sets, 397, 484-494, SOI 

assignment, 484-48S, 491-492 
base type, 484, 493 
cardinality, 484 
comparisons,494-49S 

syntax box, 494 
complement, 490 
constants, 487 

syntax box, 487 
declarations, 484 

syntax box, 486 
difference, 488, 490 
empty, 487 
equality, 492 
in, 492-494 
input, 491 
intersection, 488, 489 
operations, 488-492, SOI 

syntax box, 491 
order of members, 48S 
union, 488 
variables, 477 

SetDrawingRect, 367-368, 391 
syntax box, 368 

SetPt, 108, 136, 201, 63S 
syntax box, 107 

SetRect, 104, 108, 117, 136, 201, 367, 63S 
order of parameters, 104 
syntax box, I 04 

SetTextRect, 367-368, 391 
syntax box, 368 

Seuss, Dr., S90 
Show Error, 639 
Show Finger, 641 
Show Selection, 639 
ShowPen, 373, 37S, 63S 

syntax box, 37S 
Shut Down, xxv 
Sin, 632 
Software, x, 2 
Sorting, 3S3 
Source Options .. ., 270. 640, 649, 6S0-6SI 
Source code, 17 
Space character, see Blank character 
Special case, 23°5, 239, 246 
Special menu, xvii, xviii 
Spelling check, 353 
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Spreadsheet, 288 
Sqr, 203, 632 
Sqrl, 203, 632 
Square brackets, 400 
Stacks,397,566-583,619 

·accessing elements, 567 
empty, 569, 576 
implemented as array, 575-579 
implemented as linked list, 579-582 
implementor's view, 575-582 
initiillizing,569,576 . 
operations, 566 
overflow, 569 
popping, 577, 581-582 
pushing,577,579-580 
user's view, 566-575 

~tart-up disks, xii, xxi, xxiii, 7, 326 
Starting a program, 235-237 
Statements, 3 
Static data structures, 510 
Step, 76, 269, 282, 638, 640 
Step Into Calls, 641 
Step-Step, 80, 269, 282, 638 
Siepping through loops, 163-168 
Stepwise refinement, 25, 38, 234, 235, 582 
Stop button, 170, 185, 363-364 
Stop signs, !ID-83, 85, 162-168, 270, 274, 

282, 
Stopping state, 593 
Stops In,80,638,641 
Stops Out, 83 
Storage, 3 
Stiing,27,287-313,322,398,555 

assignment, 291 
char, 291 
compari~. 293-294, 601 
Concat,299-301,313,633 
Copy, 301-304,309,313,633 
fonnatting in output, 294 
functions,298-307,633 
Include, 305-307, 313, 633 
input, 292 · 
Lenlth,299,309,313,633 
length of, 291, 294, 295, 299 
literal, 290 
maximum length, 291, 313 
in memory, 513 
Olllit,304-306,313,633 
operations, 298-307 
output, 294 
parsing, 301 
Pos, 301, 303, 313, 429, 633 
referring to individual character, 297, 313 
reading from files, 333 
removing, 305-307 
i:eplat;ing, 305-307 
trimming b~. 308-309, 311 
variables, 290-294 

syntax ,box, 292 · 
Strµcture (in prog[amming), 2 
Structured display, 366 · 

Stubs, 279-280, 282 
Subranges,485-486,501 

as base type, 486-487, 493 
Subscript, 398, 400, 418-420, 436, 511 
Subsets, 492, 494 

syntax box, 494 
Succ,481-483,501,633 

syntax box, 483 
Supersets, 494 

syntax box, 494 
Symbolic constants, 68 
Syntax, 15, 27 

box, generic, viii 
Syntax error, 16, 19,38-39,53,267 
System Folder, xx, xxi 

Ta!>, length, 650 
Tag field, 494, 495, 497-499, 501, 502 
Test cases, 183 
Test data, 267-268 

categories of, 267 
"trick" in creating, 268 

Testing, 272 
Text 

feedback, 361-363 
input procedures , 634 
output procedures , 634 

text, data type, 329, 350 
TextEditor,324-326, 326-329,350 

building, 327 
choosing file, 328 
Edit menu, 325, 328 
initial window, 324-325 
insertion point, 324-325 
leaving, 326 

Text menu option, 638, 641 
Text processing program, 324 
Text window, 12, 366--368, 649, 650-651 

changing font, 649 
writing to, 343 

then, see if-then 
Thumbs-down icon, 18, 19, 267 
Title bar, xv, xvi 
Toggle, 83 
Tolerance, 215 
Top-down design, 234, 281 
Tower of Hanoi, 590-593, 595 
Trace,80,269,640 
Transfer ... , 639 
Translating 

Pascal to machine code, 5 
pseudocode to code, 255-257 

Trasb can, xii, xxi-xxii 
Tree, see Binary tree 
Trini, 308, 337,538 
TRUE, 123 
Truru: , 53, 84, 201, 209 

syntax box, 53 
Truth table, 138-139 
Two-dimensional arrays, see Arrays, 

Multi-dimensional arrays 
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Two-dimensional tree, 624 
Two-way parameters, see Parameters, variable 
type declaration, 40~8, 436, 449, 453, 

469,479,484,495,501, 515, 516,522 
syntax box, 407 

Types, 
predefmed,406,62~30 
QuickDraw, 406 
see also Data types 

UCSD Pascal, 298 
Undo, in layout, 567-582 
Undo, Edit menu, 639 
Union, 488-489, 501 

syntax box, 491 
Units, 554 
Unstructured programming, 47, 234 
Untitled window, see Program window 
Upper limit, loop, 160 
User, 267 

assumptions, 381, 359-360 
friendliness, 360-368 
interaction, 235 
interface, 91, 235, 239, 245, 321, 360-368, 
390, 424 
view of abstraction, 558-560, 582-583 
vs. implementor, 381-382 

User's guide, 380-381 
uses, 370, 630 

syntax box, 370 
Using this book, vi 
Utilities, 6, 38 

Value parameters, see Parameters, value 
var parameters, see Parameters, variable 
Variables, 45, 191, 398 

checklist, 72-73 
declarations, 46, 47, 83, 196, 371 
file, 329-330 
garbage, 49 
local, 48 
naming, 45, 48-49 
output of, 6H6 
pointers, 511, 515-516 
records, 449 
representation in memory, 46 
sets, 484, 486 
string, 290-294 
text, 350 

undeclared, 267 
Variable parameters, 200-207 

as alias, 206 
declarations, 202 
vs. value parameter, 207 
see also Parameters, variable 

Variant fields, 494, 497-499, 501-502 
Variant records, 494-501, 501-502 

and case statements, 499 
declaration, 495 

View Options. •• , 640 
View menu, xvii, xxii 
Visual continuity, 366 

Wedge, painting, 101 
see also Arcs 

What to find, 638, 646 
while, 159, 172-179, 184 

vs. repeat, 174-179 
Window, xiii, 649---050 

activating, 13, 649 
active, xx, 1 J · 
anatomy of, xv 
enlarger, xvi 
moving within, xvii 
rearranging icons, xviii 
repositioning, xvi 
title, xv· 

Windows menu, 
Pascal, 12, 13, 21, 54, 75, 341, 638, 641, 
644,64~50 
Text Editor, 324-325, 329 

with,457-461,469 
syntax box, 458 

Word symbols, 629 
lVrite,27,38,44, 84,634 

to files, 341-344, 634 
syntax boxes, 28, 66, 343 
see also Output 

Write-only, 322, 323, 341, 342, 348, 349 
lVriteDraw, 56, 59---00, 635 

syntax box, 60 
lVriteln , 13, 44, 57, 341-344, 634 

files, 341-344, 634 
syntax boxes, 28, 66, 343 
using variables, 63---06 
see also Output 

x-y coordinates, see Coordinates 

Index 



on the 
Macintosh 

A Graphical Approach 

David A. Niguidula · Andries van Dam 
Brown University 

Pascal on the Macintosh: A Graphical Approach provides a new and appealing way to learn introductory pro­
gramming. Developed at Brown University, a leader in undergraduate computer science instruction and computer 
graphics research, this book combines a thorough discussion of programming in Pascal with the distinctive 
program development tools of Macintosh Pascal and Llghtspeed Pascal and the basics of interactive computer 
graphics. As the many examples and exercises clearly illustrate, graphics programs have a visual appeal and 
impact that cannot be matched by traditional number-crunching programs. Pascal on the Macintosh: A Graphical 
Approach shows programmers at any level how to use the expressive power of graphics effectively and easily, 
while teaching new programmers the fundamentals of the problem-solving approach to software development. 

HIGHLIGHTS 

• Provides enough detail to take full advantage of the unique debugging and formatting facilities available 
with both Macintosh Pascal and Llghtspeed Pascal, yet is general enough to teach principles applicable to 
programming in any procedural language on any machine. 

• Uses a wealth of graphical illustrations to provide an easy, step-by-step guide to program construction 
and execution. 

• Does not require previous Macintosh or computer experience. 

• Includes all the fundamental concepts of programming, plus linked lists, stacks, queues, binary trees, 
and other advanced topics. 

• Includes a chapter-length example of program development. 

• Shows how to create simple but effective graphical user interfaces. 

• Contains hundreds of full-length programming projects as well as varied exercises that test 
individual concepts. 

ABOUT THE AlITHORS 

David A. Niguidula and Andries van Dam revamped the introductory programming course at Brown University 
in 1983 to take advantage of the new generation of graphics workstations. Mr. Niguidula is now affiliated with 
the Educational Technology Center based at the Harvard Graduate School of Education. Dr. van Dam has taught 
Brown's introductory programming course and graphics course since 1965. He is coauthor (with James Foley) of 
Fundamentals of Interactive Computer Graphics, the standard textbook in computer graphics. Dr. van Dam also 
served as chairman of the Brown University Department of Computer Science for nine years, and is a cofounder 
of SIGGRAPH, the Association for Computing Machinery's Special Interest Group on Computer Graphics. 

Addison-Wesley Publrshittg C~mpany ISBN 0-201-16588-0 . 


